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Description of Above & Beyond

Above & Beyond is a powerful system for planning, managing, and tracking one's active 
business and personal life.    Innovative dynamic schedules manage workflow more 
effectively than any other method.    All types of recurring activities need be entered just 
once.    You can print schedules to take your plans wherever you go.    Above & Beyond also 
includes a pop-up calendar, alarms, task and event timers, week and month at a glance, and
much more.    There's no better time management system than Above & Beyond.

With Above & Beyond, you can plan time for everything you want to do!

Above & Beyond is also ideal for workgroups.    Where workstations are connected via a local 
area network (LAN), managers can balance the work-load of staff members, assign new 
items, prioritize work, as well as check task completion status without interrupting on-going 
work. Above & Beyond naturally automates the process of arranging meetings for group 
members; posting meeting notices to all attendee's schedules. Secretaries can post phone 
messages for calls to be returned, and monitor multiple schedules to know who is where 
when. 

Above & Beyond streamlines work-flow and productivity soars!

Powerful Advanced Scheduler

Above & Beyond is the world's most advanced time management system. It's amazing 
effectiveness is primarily due to what is called dynamic scheduling. In the section Dynamic 
Scheduling that follows, you'll start to discover how much this can benefit you.

You may just now be discovering Above & Beyond. Welcome! 

Share the Benefits

Certainly many people you know could benefit from using this High Achievement System.    
We encourage you to make copies of Above & Beyond, and give them to others to evaluate; 
or upload Above & Beyond to your local BBS.

Price

Above & Beyond for a single user is    $149.    A five user LAN system is $495.    Ten users: 
$895.    Fifty users: $3495.    One hundred users: $5995.    Call 1Soft at 707-987-0256 for 
additional information on specific size configurations.

Send your comments and suggestions

Product questions and requests for enhancements are welcomed (and always considered). 
Please address your comments to:

1Soft Corporation
Product Comments



Post Office Box 1320
Middletown, CA    95461



Registering Above & Beyond

Be sure to register Above & Beyond by ordering a license:

1.    Select the Options menu and choose Order an Above & Beyond License.

2.    Type in the requested information and click on "Print".

3.    Mail both copies with your check (or credit card number and expiration date) to the 
address on the form.    We accept Visa. Mastercard and American Express.    If paying with a 
credit card, you can FAX your order form to 707-987-3150.    If you have questions about 
your order, call 1Soft    Corporation at 707-987-0256.    

Note: If you already paid for the complete package, you'll have a light-blue registration card. 
In that case, choose Options: Order a Pre-paid Above & Beyond License.    Print and mail the 
order form with the completed registration card.

The Complete Package

When you purchase an Above & Beyond license, you will receive the complete package 
including the spiral bound User's Guide and program disks in both 3.5" 720K and 5.25" 360K 
formats.

As a registered (licensed) user, you'll also receive a personal User ID and substantial 
discounts on product upgrades.



Distribution Information

You are authorized to make only exact copies of Above & Beyond files to give to others for 
evaluation purposes. Modifying the original content in any way at any time is strictly 
prohibited. This also prohibits temporary modification while the binary data is in RAM. 
Archiving (compressing) distribution files is permitted only for efficient transmission and 
must not alter the original content.

Only individuals licensed by 1Soft Corporation are authorized to use Above & Beyond files on
a continuing basis. Continued active use without registration is prohibited. No other parties 
have been authorized to sell or grant licenses. Various shareware distributors have been 
authorized to sell disks containing Above & Beyond. They are selling disks and a distribution 
service only. They are not selling Above & Beyond licenses.

Liability Disclaimer

1Soft Corporation specifically disclaims any warranty of merchantability or fitness for a 
particular purpose. With respect to defects in its programs and supporting materials and 
service, in no event shall 1Soft Corporation be liable for any loss of profit or any other 
commercial damage, including but not limited to special, incidental, consequential, or other 
damages.

Copyright/Trademark Information

The software files that comprise Above & Beyond are Copyright © 1992 by 1Soft 
Corporation.    All rights reserved.    Unauthorized use is a violation of U.S. and international 
copyright laws.    1Soft and Above & Beyond are trademarks of 1Soft Corporation.



Installing Above & Beyond

The installation process allows you to select where you would like to put Above & Beyond 
files. The directory you name will be created if it doesn't already exist, and the files will be 
copied from the diskette(s) to this target directory. Some files are in compressed form on the
diskette(s) and will be automatically uncompressed as they are installed.

Step 1:Insert the Above & Beyond diskette into drive A:

Step 2:In the Windows Program Manager, Select Run from the File pull-down menu and type:

A:INSTALL

Step 3:    Create a program item (an icon) in the program group of your choice, eg. Windows 
Applications. From the Program Manager, select File, and choose New. Select Program Item. 
As a description, you might type in your name, and for the command line, state the path and
program file, for example:    C:\ab\AB.exe

You can also specify a datafile name, such as:    C:\ab\AB.exe Robert      The extension will be 
assumed as PAK.    When you omit the datafile name, the name used is TIMEDATA.PAK by 
default.

If you have a TIMEDATA.PAK file from a prior version of Above & Beyond, it will be 
automatically loaded when you start Above & Beyond 2.0; unless it is stored in a different 
directory.    In that case, copy it to the directory where Above & Beyond has been installed.

Step 4: Start Above & Beyond by selecting the icon you have created and either pressing 
Enter, or double-clicking with the mouse.

Installing Above & Beyond for a LAN Workgroup

Although you can install the program file AB.exe in a shareable directory on the server, and 
have your workstations access it there, it will run faster if installed locally. This is because 
Windows will not have to repeatedly access the server hard drive to read parts of the 
program code into memory. If installed on the local workstation, Above & Beyond will not 
only load quicker, but it will also operate at a faster, more responsive pace. This is true for 
all Windows applications. 

The installation is the same as described above in the section "Installing Above & Beyond" 
with one exception. You will want to have datafiles reside on the server's hard drive. It's 
recommended you designate an individual directory for each user. This will keep .log files 
(completed items are tracked in these files) for each user from being combined.

When you run Above & Beyond, if the directory and/or file you specify does not yet exist it 
will automatically be created for you.

Suppose you have four users: Bill, Karen, Cindy, and Robert;    and the name of your server 
drive is "J". The command lines on the workstations could be as follows:

On Bill's workstation: c:\ab\AB.exe    j:\Bill\Bill

On Karen's workstation: c:\ab\AB.exe    j:\Karen\Karen



On Cindy's workstation: c:\ab\AB.exe    j:\Cindy\Cindy

On Robert's workstation: c:\ab\AB.exe    j:\Robert\Robert



Dynamic Scheduling

Above & Beyond is designed to organize your life and maximize your productivity. It can plan
time for everything you want to do! 

Much of the superior power and flexibility of the Above & Beyond system is based on its 
unique automated scheduling of floating tasks. These schedules are so effective, they render
to-do lists obsolete. Floating tasks are to-do tasks. Unlike fixed items such as appointments, 
they don't have to be done at a precise time. Most of the items of work you do each day are 
floating tasks. These tasks have an anticipated duration to be planned for, but they can be 
performed during some range of hours. Automated scheduling of to-do (floating) tasks 
allows you to plan more precisely than you could with a list, and see clearly how your time is
being allocated. The benefit of using these flexible dynamic schedules is tremendous. The 
following pages detail some of the advantages.

Productivity Gains Through the Day

The best way to illustrate how you can save time throughout the day is to look at a typical 
day, and compare using a to-do list to using Above & Beyond's dynamic schedules. If your 
to-do list has 100 items, and the average task is 15 minutes, then every 15 minutes or so 
you have to stop and decide what to do next. Suppose you spend only one second 
considering each item as you scan a to-do list of 100 items. That's over a minute and a half 
for each scan. If you finish 40 items you will have repeated this scan 40 times in the day, 
spending an hour in the process. This lengthy scanning is eliminated with Above & Beyond. 
You glance at your schedule, see what's next, and begin it without hesitation. You finish 
these 40 items an hour sooner!

And if circumstances require changing your plans during the course of the day that's easy 
with Above & Beyond. If you're at your PC, the schedule on-screen instantly reflects your 
changes, or if you're using a printed Above & Beyond schedule you can make your changes 
on paper, marking up the alterations in your own shorthand.

Having your workflow streamlined leads directly to much higher achievement every day. 
Above & Beyond will boost your performance and rewards in all your pursuits. And provide 
you with more time for leisure pursuits!

Rewards of Higher Achievement

Imagine saving 60 minutes every day! That's 365 hours a year. What would you do with an 
extra 365 hours a year? You've gained the equivalent of nine 40-hour work-weeks. 

Depending on your lifestyle that might translate to an extra two months of vacation, a 18% 
boost in billable hours, self-employment earnings, or commisions, or a hefty raise at your 
next performance review.

Dependability

Above & Beyond reminds you of everything you need to do at the appropriate time. Being 
able to follow-through on promises and commitments you make to others will strengthen 



your reputation for dependability. People trust individuals that have a history of doing what 
they say they'll do. With Above & Beyond, you have the tools necessary to plan with 
confidence. You'll gain the ability to follow through on what you plan to do.

Greatest Return

You'll use daily schedules to eliminate time wasters, planning on doing only what will bring 
you the greatest return.    

Knowing When You'll Get to It

Workload cycles from lulls to hurricanes can be trimmed. 
 
Like most people, you probably feel very busy most of the time. But once in a while things 
slow down. Sometimes suddenly. Maybe you can recall a day when you thought at one point 
"what should I do next?" and nothing especially urgent came to mind. So the rest of your 
day wasn't fully utilized. Lack of challenge can lead to boredom. Often after lulls pass, a 
period of the being too busy comes surprisingly soon: a crisis of not enough time.    
 
Few of us have a life which naturally delivers opportunities to act in a steady flow.    We can 
even exacerbate the ups and downs unwittingly. We may react to a period of too little to do, 
by taking on more and more. Then during a crisis of extreme busy-ness, we may refrain from
accepting any new challenges, and wind up with a lull of nothing interesting to do, when the 
storm passes. 
 
With this scheduler, you can see light periods in advance, and plan accordingly. And you can 
see when future days are filling too rapidly and not take on quite so much before a crisis of 
deadlines occurs.
 
When a lull can be anticipated weeks ahead it can be prepared for and not be dull. Knowing 
you'll be ahead of    your workload a few weeks from now could mean planning for an 
delightful vacation!

Reasonable Expectations

Being able to look ahead and plan reduces stress, and    allows you to inform others. Once 
you have entered your pending tasks you will notice a marked decrease in stress. Because 
all of your tasks are now in a place where they can be managed effectively, you don't have 
to depend on less reliable methods to jog your memory. It's all covered. You can relax. 

Schedule Pacing

Daily schedules enable you to quickly gauge whether you are behind or ahead of schedule 
based on how much you have completed.

Productivity Push

When you know you have a schedule of many vital tasks planned for accomplishment, 



you're more likely to use your time effectively. You know what's next and you know that the 
time you've planned for the current task is finite. Without a planned schedule, there's a 
tendency to merely continue with the comfort of the current task much longer, realizing 
diminishing marginal returns for the extra time spent. With a schedule, you're much more 
likely to move on to the next item. 

Transition Time

No more scanning long to-do lists, plus wall calendars, and appointment books.    Smoother 
transitions boost productivity and effectiveness. 
 
With a to-do list, and no schedule, you know what you have to do, but don't have a plan of 
when to do it. And you don't know what length of time the workload represents. So you 
select one task, and work on it for a while. Then you go back to your list and select the next 
thing, and begin doing it. This creates stress, because you know that if you could anticipate 
what was coming next, you'd be better ready to attack it. One of the big advantages of a 
schedule is that you know what's next. While you're working on task A, you can be preparing
to do task B subconsciously.    You know in advance what tasks you'll encounter throughout 
the day, and in what order. If you've ever watched the Olympic track and field athletes, you 
know that the winning sprinter doesn't stop between hurdles. Running fast and not slowing 
between hurdles is the key to winning times. Imagine if the hurdles are all different heights, 
such as the events in your day. Then anticipating each successive hurdle becomes even 
more crucial. There is a natural desire to look forward to things. To know what's coming, and 
prepare for it. Schedules allow us to do so. 

Window of Opportunity

People rarely forget; they just miss the opportunity window.    Many tasks you seek to 
accomplish can be done only between certain hours. To-do lists hide this fact. If it's a phone 
call to return between certain hours, or an errand that needs to be accomplished within a 
two-hour time frame, then it's a task that cannot be done anytime. Think of all the times 
you've heard yourself say "Ooops I forgot to...." You remembered the task, but only after the 
opportunity was missed. A schedule provides the means to plan time-frame sensitive tasks. 

Log Files

Recall exactly what was done and when, with confidence.

Relief from Office Clutter

Another benefit is helping to keep your desktop and office less cluttered.    A device often 
used to remember tasks, is to leave something related to the task in a conspicuous place 
that will be noticed. Unfortunately, for an active person with much to remember, this can 
lead to an office in complete disarray.    This scheduler allows you to file or store away task 
materials with the confidence that the schedules will show pertinent tasks at the appropriate
time. 



Focus

You can focus mentally without the distraction of thinking about other tasks: trying not to 
forget them, or wondering whether they should be worked on now instead of your current 
task. 

Increased Productivity

While you may grow accustomed to having less time-pressure stress in your life, another 
major benefit will be a dramatic boost in productivity. You'll be amazed at how much you 
accomplish.    You'll get more done in less time. 

Above & Beyond Breaks New Ground

Above & Beyond introduces a new, and more effective way to manage your time. Instead of 
having tasks merely listed in a to-do list, they can be scheduled in the available time 
between the appointments on your calendar. There are several advantages to this approach:
a unified view, time budgeting, time-frame targeting, transition smoothing, and more. 

Integration: a Unified View

Having a unified view means that you don't have to split your attention between your 
appointment calendar and to-do list. Everything you have planned is arranged in the day's 
schedule. No longer do you have to split your attention; you can focus. 

Time Budgeting

Tasks will be scheduled automatically.    At a glance, you can see how much can be 
accomplished and how much space remains in a given day. This minimizes the number of 
surprises and crises that arise when insufficient time remains to accomplish high priority 
tasks before a deadline. And since a schedule is much more precise than a to-do list, you 
can more easily make and keep your commitments to others. You can tell them in advance 
exactly when you plan to have something done. 

Doing it All

One of the most frequent causes of stress we have all experienced is the feeling of having 
too much to do. More specifically, we have a lot to do, and aren't sure if we'll get it done in 
time.    It's this doubt and worry that brings on stress.    Now you can see exactly what you 
have to do and how long it's going to take. Then if it cannot be accommodated before 
deadlines, you can defer lower priority tasks. A renewed sense of confidence in knowing 
what you can get done, and when, will greatly lower your stress level. 

Forget it Not



Another source of stress is worry over forgetting to do certain things before they must be 
done. We all use methods to combat this threat. Unfortunately the methods are not always 
reliable, and result in a certain amount of stress. The key to reducing this stress is simply 
finding a more reliable means to keep track what has to get done, and being reminded of it 
when there's time to do it (before it is too late). 

A More Exciting Life

You will naturally feel more excited about life as you put this time planning system to use. 
With a greater potential for higher productivity you can accomplish all the things you need 
to do, and find time for more of the things you want to do. 

Daily Use

You can gain most of the above benefits even if you use a PC only about twenty minutes 
each day. 

The Morning Planning Session

First, check-off the items that have been completed.    Then reschedule the tasks you didn't 
get to.    You may reschedule them to today's schedule by simply pressing F12.    Or 
reschedule to the date of your choice by clicking on that date on the pop-up calendar with 
the right mouse button.    To view that date, click with the left button.

Add New Items

Add any new items. These might be items you're carrying in your head or those you jotted 
down on yesterday's printed schedule page. 

Arrange Your Schedule

Using the keyboard or mouse, move the items in today's schedule around so that today's 
schedule best suits you. Often today's schedule will be overloaded, but you can defer items 
by rescheduling them to future days.    And you can adjust today's sequence so there are no 
conflicts, and items are in the order you desire, bringing related items together, for example.
As you make changes, you'll notice that the schedule will adjust automatically. 

Print a Schedule Report

You'll want to print off today's schedule, and normally also the extended outlook. The 
extended outlook includes a 3 month calendar, and any highlighted events for up to 90 
days.

It's possible to print your schedule on one-side of the sheet of paper, and turn it over and 
send it through the printer for the extended outlook on the back. This means that you only 
have to carry a single sheet of paper with you throughout the day, which is much easier than
a bulky appointment book, not to mention easier to update.

Jot notes on your schedule report during the day; cross-off items you complete.    Use the 
extended outlook to pin-point what times are committed so you can schedule appointments 



even while away from your PC. 

Suggestions and Tips

Enter the items you plan to do, including regular (recurring) items. This can be done very 
quickly. In the span of about 15 minutes you can probably enter 50 items. Don't forget to 
include the many things you do everyday, such as lunch. These need be entered only once; 
time each day will be reserved for them. There will be additional tasks that you'll think of 
later, and you can enter them anytime. 
 
Then plan today. If today's tasks are not already in a sequence that suits you, arrange them 
and make adjustments, and then print your schedule for the day. If you have a printer, you 
can make a printed schedule to carry through the day, crossing-off items that you complete. 
New items can be noted on this same page, and entered the next morning. If you're using 
the printed schedules and only running the software once daily, you'll spend about 10 to 20 
minutes updating information by marking completed events, entering new schedule items, 
and adjusting your plans according to your latest priorities.

Tasks that you want to reschedule you'll move to future days. The pop-up calendar is handy 
for rescheduling, since you just click the right mouse-button when over a calendar day and 
the selected event will be moved to that day. The updating process is finished when only 
crossed-off items remain on yesterday's schedule. You can edit any of the crossed-off events
to alter the begin time, duration, or other attributes. Yesterday's schedule will later be 
archived to log what you've accomplished. 

Making Backups

Backing up your vital scheduling data is very important. We recommend Making daily 
backups of your data files (*.PAK files) in case a file should get lost or damaged.    Also it's a 
good idea to make at least one backup copy of the program files in    case something should 
happen to the original disk.    For more information, see Data Saving and Making Backups in 
the section entitled "Using Above & Beyond".



Workload Balancing

Workload balancing enables you to automate your planning sessions. And it boosts your 
level of achievement throughout each day. You'll save time planning, and be able to perform 
your work more effectively, accounting for all prorities and deadlines. Any tasks you plan on 
doing that don't have to be tied to a particular date can be designated as "Fluid" items and 
carry a priority and deadline. When you issue the Balance Workload command, Above & 
Beyond will reflow your schedules so that each day is optimized at ideally 100% capacity. 

How Workload Balancing Saves You Time

Workload Balancing relieves you of the work of manually rescheduling/postponing tasks 
when the schedules for the near term are overloaded with items. For most people the near 
term being overloaded is an every day situation. But you can change that with Workload 
Balancing. Automated balancing of the workload is fast, and takes into account all priorities 
and deadlines. 

Life Without Workload Balancing

Suppose for example that you've just carried forward all undone items to today, and you're 
looking at a schedule that's overloaded. Your day is 8am to 10pm, yet there are 70 items, 
totalling 22 hours worth of time packed into the schedule. If you rescheduled 35 of these 
items by hand using the pop-up calendar you might choose from any of the days later in the 
week. That might take 15 seconds per item for you to read the item, and chose a future day 
to reschedule it on. For the 35 items that you decide to keep on today, suppose it takes 7 
seconds each. That's about 14 minutes total. And even if you did this, you'd have broken 
your priorities. Originally, everything on tomorrow's schedule was lower priority than the 
items on today's schedule, yet you've just moved many of today's items to after tomorrow. 

Above & Beyond with Workload Balancing of Fluid items will save you those 14 minutes each
day, and maintain your priorities.

Priorities

Fluid items each have a relative priority from 1 to 999. When you issue the Balance 
Workload command, all Fluid items are rescheduled dynamically. Precedence is given to the 
items in their order of priority. This means that all things being equal, higher priority items 
will be scheduled earlier than lower priority items. The priority 1 item may be scheduled 
today, for example, and the priority 145 item may not come up until next month.    See also, 
the section below titled Changing Priorities.

Earliest / Latest Dates And Weekdays

There are additional properties that fluid items have. The earliest date is known as the 
Postpone date. It is the earliest possible date you would want the item scheduled. The 
Deadline date serves as a latest date. It's the latest possible date for it to be scheduled. For 
tasks that you would only want scheduled on particular days of the week, you can indicate 
with the weekday check boxes. For example, you might designate just Saturday, or maybe 



only Monday through Friday. These properties can be set on the Edit item dialog box. The 
Postpone date, Deadline date, and Weekdays are all optional.

How To Create A Fluid Item

If you're in the "Insert/Refine Item" dialog box, click on (to remove the X from) the Firm 
checkbox. This will switch off the Firm setting, making the item Fluid. If you are inserting an 
item from the Priority Ordered List view, the box will automatically be switched off to give 
you a Fluid item initially.

To toggle an item between Fluid and Firm press F2, or choose "Fluid Item" in the Edit menu.

Recurring items are normally not fluid, but you can make an exception. If you press F2 on an 
instance of a recurring item, it will change it to an exception and make it fluid.    Or select 
"Exception" in the Insert/Refine Item dialog box and then switch off the Firm check box to 
make that instance Fluid.

Changing Priorities

The top priority item has a priority value of 1, the next 2, etc.    You can view all the Fluid 
items by selecting View: Priority List. The priority of an item can easily be changed in several
ways. You can slide the item up or down in the priority list to raise or lower its priority. Or you
can edit the item and change the priority value by typing in a new value; or using the scroll 
bar to quickly move it up or down. 

The Balance Workload Command

Simply press ALT+F8 (or select Juggle: Balance Workload) and Above & Beyond will adjust 
item scheduling on all future days. The priority, duration, and begin time (if any) is taken 
into consideration. Higher priority items are given precedence, but there are exceptions. 
Items of shorter duration, for example, are easier to find time for, and may be scheduled 
before a long duration item of higher priority. 

If time cannot be found for the item before its deadline, a warning message will appear, and 
you'll have an opportunity to make changes, such as increasing its priority or extending its 
deadline. When no messages appear you will know that all tasks have been scheduled 
before their deadlines.

Using The Pop-up Calendar With Fluid Items

The popup calendar, so useful in quickly rescheduling Firm items, also has benefits in 
juggling Fluid items.    If you want to postpone a Fluid item to next week, click the right 
mouse button on the date you'd like to postpone it to. Don't worry about postponing past the
deadline, because Above & Beyond will check deadlines and warn you if you pass one. You 
can then chose to not postpone the item, or have the deadline extended. When you 
postpone an item it will not be scheduled prior to that date.    If you later decide you want to 
move it up, you can do so by clicking on an earlier date on the calendar.    The Postpone and 
Deadline dates can also be changed in the Insert/Refine Item dialog box.



Make Whatever You Can Fluid

To get the greatest gain out of Workload Balancing, designate as many items as you can as 
Fluid. Ask yourself, "Can this be done on other than one particular date?"    Events and 
appointments are normally Firm, and would not be Fluid items. But many things, perhaps 30-
60% of your items could be Fluid. The more fluidity you can designate in your schedules, the
easier it is to balancing your workload.

Here's a summary of the Fluid/Firm and Floating/Fixed options:

Firm - Must stay on the date it is scheduled for
Fluid - Not Firm
Fixed - Must stay at the time it is scheduled for
Floating - Not Fixed

So there are four possibilities:

Fluid & Floating - Any date, any time
Fluid & Fixed - Any date, specific time
Firm & Floating - Specific date, any time
Firm & Fixed - Specific date, specific time

If floating items are firm, Above & Beyond will assume that the order    of the floating items is
important and will not alter it; as it would with fluid items when the Balance Workload 
command is selected.

How To Handle The Unexpected

If your work and lifestyle sees unexpected items come up at the last minute, you may want 
to adjust workload balancing so that it doesn't try to plan a solid day everyday for you. 
Suppose your waking day is from 8am to midnight, 16 hours, but you want to allow for 4 
hours of unexpected items. Create a daily recurring item titled "Unexpected" that lasts 4 
hours.    (Two items of 2 hours each will work even better). Workload balancing then will take 
the unexpected blocks of time into account when scheduling fluid items. 

What If The Schedule Still Jams Up?

At the top of each schedule there is displayed the amount of Conflict time. This is the total of
any overlaps among items in the viewed schedule. Conflict time will ideally be close to zero 
when using Workload Balancing, but it you have too many Firm items on a particular day, 
the schedule will still be jammed after Workload Balancing. The solution is to either 
reschedule these Firm items manually or toggle them to Fluid items where feasible.

When To Use The Workload Balancing Command

With experience you will become adept at using Above & Beyond in just the fashion that 
suits you. But to give you a headstart, here are some suggestions. We'll suppose you're 



having a single planning session each day.

1. Review yesterday's schedule, checking off done items, and filling in their hours if you 
want an accurate log. If you edit them in order, you will find that Above & Beyond will fill in 
alot of the values for you. For example, when you check off an item, it changes the begin 
time to coincide with the end time of the previous item in the schedule. If you're adding 
items that were done yet not in the schedule, use F10 (Insert Done Item). The begin time will
also be filled in here automatically, based on the end time of the    currently selected item.

2. Issue the Carry Over Undone Items command.

3. Insert any new items, and delete any obselete ones.

4. Go to the Priority List View. Review your priorities and make any adjustments.

5. Issue the Balance Workload command.

6. View today's schedule, and arrange it to suit your preferences.

7. Print today's schedule. If you think you might have extra time open up, print the First Page
of the Priority List which will give you a priority ordered list of items.

Time Savings with Workload Balancing

The 14 minutes estimated previously for rescheduling a busy schedule manually can all be 
saved each day by taking advantage of WORKLOAD BALANCING. That'll save you 90 hours 
annually. Enough time for an extra two week vacation every year.

Tips on Juggling Priorities

Workload Balancing is of most value to those with particularly heavy workloads. If you find 
that your List of Fluid items grows to more than 20 items, there's an additional tip that will 
help. It's conceivable your priority list could have more than 100 items. Suppose you have 
150 items. You wouldn't want to review the priorities and make adjustments of all 150 items 
everyday. Probably only the first 10 or 20 are going to come up right away. Focus on those. 
To make it easier, create an item with a title such as "------- LATER ------" you can then use 
this item as a placeholder at some comfortable position in the priority list. You can more 
easily organize just the group of top items that you are actively prioritizing each day. If you 
have a major milestone coming up and want to defer items until after it, you could create an
item such as "----- AFTER THE XYZ PROJECT IS DONE -----".



Schedule Notation

The first line of each schedule displays a convenient summary of the schedule shown in the 
window.    What is displayed is the day and date of the schedule, the number of items in that 
day's schedule, the amount of time taken up by the items in the schedule, and the amount 
of time left unscheduled in that day (open or free time).    If there are "conflicting" items -- 
items that are scheduled for the same time period -- the total overlap time is displayed.    On 
past schedules, the number of undone items will also be reported in the banner line.
 
If the schedule being viewed is the one for the current day, an asterisk (*) will appear after 
the date in the banner line.      
 
If the schedule being viewed is not the schedule for the present date, a number will appear 
after the date in the banner    line preceded by a plus (+) or a minus (-).    A number 
preceded with a plus indicates that the schedule being displayed is that number of days in 
advance, or in the future, of the present date.    A number preceded by a minus indicates 
that the schedule shown is that number of days behind, or in the past from, the present 
date. 

An arrow (>) will appear before the title of the item that is scheduled for the current time.    
A tilde (~) will appear before the title of fluid items.    Schedule statistics will change as items
are added, deleted from or modified in a schedule or as schedules for different days are 
selected.

A small digital clock will appear in the lower right hand corner of the screen whenever Above
& Beyond is running.    To switch back to Above & Beyond from another application simply 
click once on the clock.

Start Times Grayed

On today's schedule, item start times will appear gray if the start time has already past.    
Also, if you move an item to a spot where it conflicts with another item or goes outside of 
the time bounds you designated, the time will appear gray; warning you of the conflict.    
Keep this in mind when juggling items.

International Time & Date Formats

Above & Beyond supports world-wide date and time formats.    Use the Windows Control 
Panel to select your choice of time and date format.    For example:

14:00 dd/mm/yy Australia, United Kingdom, Belgium, Brazil
14:00 dd/mm/yy Italy, Netherlands, Iceland, Spain, New Zealand
14:00 dd.mm.yy France, Germany, Norway
15.00 dd-mm-yy Denmark
15.00 dd.mm.yy Finland
16,00 dd.mm.yy Switzerland
2:00 dd/mm/yy Mexico, Canada (Eng)
2:00 yy.mm.dd South Korea
15.00 yy-mm-dd Sweden
14:00 yy-mm-dd Austria, Portugal, Canada (Fr)
2:00 mm/dd/yy United States, Taiwan



Selecting Schedules

See the Select menu for the commands for selecting which schedule to view.    Or simply 
click on the desired date on the pop-up calendar.

There are several methods for moving between schedule days.    You may move ahead or 
back by days, weeks, months, or years.    These methods are explained in the sections that 
follow.    Remember that no matter how far you go ahead or back in time, you can always 
return to today's schedule by simply pressing the HOME key.    

Selecting a Specific Date
Selecting a Day at a Time
Selecting a Week at a Time
Selecting a Month at a Time
Selecting a Year at a Time



Selecting a Specific Date

To select a schedule for a specific date, simply click on the desired date on the pop-up 
calendar.

Or press F9 and type in the date.    Dates may be entered as "month/day/year" using slashes,
hyphens, spaces or periods.    Often the year may be omitted.    See Entering Item Date for 
more information on when the year may be omitted.

To select the schedule "n days from now" simply type in a number "n".    To select the 
schedule one week from now, type "1w".    For two weeks from now, type "2w".    For two 
months from now, type "2m".

You may also enter the name of the day of the week, or an abbreviation such as "M", "Tu", 
"W", "Th", "F", "Sa", or "Su".    To select next Monday, type in "M".    For two weeks from next 
Monday type "M2".    For three weeks from next Tuesday, type "Tu3". 



Selecting a Day at a Time

There are shortcuts to selecting the schedule for date one day earlier or later than the one 
being displayed: 
 
Press the gray PLUS (+) key on the numeric key pad and the schedules will advance one day.
 
Press the MINUS (-) key on the numeric key pad and the schedules will roll back one day. 

Or with the mouse...
 
Click on the right-pointing arrow at the far right end of the horizontal scroll bar at the bottom
of the schedule screen, and the schedules will advance one day. 
 
Click on the left-pointing arrow at the far left end of the horizontal scroll bar at the bottom of
the schedule screen, and the schedules will roll back one day. 



Selecting a Week at a Time

There are shortcuts to selecting schedules weeks apart:

Press F7 to view the day one week earlier.

Press F8 to view the day one week later.

Or with the mouse...
 
Click in the gray area on the left half of the horizontal scroll bar at the bottom of the 
schedule window to view the day one week later.

Click in the gray area on the right half of the horizontal scroll bar at the bottom of the 
schedule window to view the day one week later.



Selecting a Month at a Time

The pop-up calendar with a mouse can be used to quickly move the display by months at a 
time:

Month to month moves of the pop-up calendar, are directed with the up and down arrow 
keys when the pop-up calendar has the focus.

Or with the mouse...

Click on the up-facing arrow at the top end of the vertical scroll bar on the right side of the 
pop-up calendar, and the calendar will advance one month.    Then, click on the desired date 
in the calendar and that schedule will be displayed. 
 
Click on the down-facing arrow at the bottom of the vertical scroll bar at the right side of the 
pop-up calendar, and the calendar will roll back one month.    Then, click on the desired date 
in the calendar and that schedule will be displayed.    



Selecting a Year at a Time

The pop-up calendar with a mouse can be used to quickly move the display by years at a 
time:

Year to year moves of the pop-up calendar, are directed with the PageUp and PageDn keys 
when the pop-up calendar has the focus.

Or with the mouse...

Click in the gray area on the top half of the vertical scroll bar at the right side of the pop-up 
calendar, and the calendar will advance one year.    Then, click on the desired date in the 
calendar and that schedule will be displayed. 
 
Click in the gray area on the bottom half of the vertical scroll bar at the right side of the pop-
up calendar, and the calendar will roll back one year.    Then, click on the desired date in the 
calendar and that schedule will be displayed. 



Inserting Items Into a Schedule

Select the schedule for the date on which you wish to schedule the item, and press INSERT.    
You can also double-click on any open space on the schedule screen (not on a existing item). 
A dialog box will be displayed which will guide you in quickly entering the pertinent 
information about your item. 
 
If you were to press ENTER, without typing any information into the dialog box, an untitled 
item would be entered in your schedule for that day at the earliest free space with a 
duration of 10 minutes. 

Entering Item Title
Entering Item Duration
Entering Memos
Entering Item Date
Scheduled / Unscheduled Items
Begin Time and Floating / Fixed
Firm / Fluid
Time Bounds
Setting Alarms



Entering Item Title

The title (description) of your item can be up to 365 characters long.    When you have 
entered the title of your item, press the TAB key to advance the cursor to the next text box.



Entering Item Duration

Here is where you enter the amount of time you think a item will take. If you are uncertain of
how much time the item will take, your best estimate will still be helpful for planning.
 
You may enter complete times like "2:00" for two hours or "1:45" for 1 hour and 45 minutes, 
or you may use the following short forms:    The numbers 1 through 99 are interpreted as 
minutes, while 100 through 2359 will be assumed to be hours and minutes.    145 for 
example is assumed to be 1:45.    You may enter durations of up to 24 hours.    An item with 
duration zero is called a "memo".

Note that a period can be used in place of the colon.    This European format is easier to type 
as the shift key is not used.



Entering Memos

To flag an item as a memo, either type "memo" or the digit "0" (zero) in the Duration box.    
When the item is inserted into the schedule, the word "memo" will appear on the right side 
of the description.    If you choose to make the item an unscheduled item (as described in the
"Scheduled / Unscheduled Items" section below), then the item will appear at the top of the 
day's schedule with the word "memo" on the left, where the begin time would ordinarily be. 

A shortcut for entering memos into your schedule is to press ALT+INSERT or select "Edit: 
Insert Memo Item".    This will bring up a definition dialog box for a new unscheduled item 
with duration zero (i.e. a "memo").    As with any unscheduled item, memos will not conflict 
with scheduled items nor be calculated into the workload by the color utilization calendar.



Entering Item Date

This is the date on which your item is to take place.    The date of the schedule which you 
selected when you called up the definition (insert) dialog box, will automatically appear in 
this box.    If you decide that you'd like your item to be scheduled on another day, enter that 
date here. 
 
Dates may be entered as "month/day/year" using slashes, hyphens, spaces, or periods as 
separators.    

Examples:  9/23/92            9-23-92            9 23 92              9.23.92

You need use only two digits to specify the year.    Specifying values between "90" and the 
"99" are assumed to be years between 1990    and 1999.    Specifying values from "00" to 
"68" are assumed to be years between 2000 and 2068.    If you omit the year, (e.g. 9/23) the 
year will be assumed to be the next occurrence of the date.    The exception to this is if the 
date is within six months in the past.    In this case the date is assumed to be the past date 
rather than the next (future) occurrence of the date.

To specify "n days from now" simply type in a number "n".    To specify one week from now, 
type "1W".    For two weeks from now, type "2W".    For two months from now, type "2M".

You may also enter the name of the day of the week, or an abbreviation such as "M", "Tu", 
"W", "Th", "F", "Sa", or "Su".    To select next Monday, type in "M".    For one week from next 
Monday type "M1".    For two weeks from next Monday, type "M2". 
 



Scheduled / Unscheduled Items

The "Scheduled" box gives you the option of having your item appear on your schedule with 
a begin time, or you may elect to have it appear    without a time associated with it, thereby 
making it an "unscheduled" item.    Designating your item or items as unscheduled is a 
convenient way to post notes or comments on your schedule. 
 
When a new item is inserted, the default setting is that it is a "scheduled" item.    To 
designate this item as "unscheduled", click the mouse on the "scheduled" check box. To 
replace the X, and make this a "scheduled" item, simply click the "scheduled" check box 
again. 



Begin Time and Floating / Fixed 

When you leave the "Begin time" text box empty, the "Floating" option is automatically 
selected. "Floating" means your item can take place over the range of time specified in 
Options: Set New Item Defaults.    The item will be inserted into the schedule at the earliest 
open time, taking into account the duration of the item, other items already scheduled, and 
the bounds you specified

With the exception of "Fluid" items described below, Above & Beyond will keep the 
sequencing of items as you have arranged them.    Because of this, you can prioritize items 
by sequencing them, and that sequence will be maintained. You can change the sequence of
items by simply dragging them with a mouse (or using the commands in the Juggle menu).
 
The dynamic scheduler    will do much of the scheduling work for you. To maximize the power
of the dynamic scheduler, omit the begin time for all those items which have a flexible start 
time.    Enter a time in the "Begin Time" box only if an item must begin at a specific time, 
such as a lunch date or meeting.    As the begin time is entered, the "Fixed/Floating" option 
automatically switches to "Fixed". 
 
In 12-hour format, times may be entered as "3:00" for 3 o'clock pm, "9:45" for 9:45 am or 
"6:3" for 6:30pm.    If no "a" (am) or "p" (pm) is typed after your time, it will automatically 
appear between 8:00am and 7:59pm. Typing "9:30" into the text box will appear as "9:30a" 
and "6:20" will appear as "6:20p".    You may also enter numerals only, leaving out the colon 
completely.    Typing "4" will appear as "4:00p" and "912" will appear as "9:12a". 

24-hour time format is also supported: "5:00" (or "0500") for 5am and "17:08" (or "1708") 
for 5:08pm.    

Use the Windows Control Panel to select 12/24-hour and international time formats. 



Firm / Fluid

In the "Insert/Refine Item" dialog box is an check box labeled "Firm".    By de-selecting 
(removing the "x" from) the "Firm" check box, items are considered to be "Fluid", which 
means that they can flow (forward or backward) between days when the Workload Balancing
command is selected.    Workload Balancing will reschedule Fluid items based on their 
priority and the best fit into the available free time.    The date range within which a Fluid 
item may flow is specified by the "Postpone" and "Deadline" dates.    That is, it will be 
scheduled before "Deadline" but after "Postpone".

For an in-depth discussion of Fluid items, see the section titled Workload Balancing.



Time Bounds

You may select a time range in which you would like to have an item scheduled.    For 
example, if you need to make a phone call to a colleague who will only be in his office 
between 9:00 and 11:30am tomorrow, enter these times in the boxes labeled "Earliest" and 
"Latest".    The dynamic scheduler will schedule "floating" items within these specified 
bounds.

In many cases you may simply leave the bounds boxes empty.    If this is done, the bounds 
used will be those you have specified in Options: Set New Item Defaults.    In addition to 
saving keystrokes, this method has the additional benefit that you may later "globally" 
adjust the bounds of all floating items by simply changing the bounds in Options: Set New 
Item Defaults.

For "fixed" items (items with a fixed begin time) the "Bounds" boxes will be seen in gray and 
will be inactive. 



Setting Alarms

Alarms may be set on any schedule item or memo.    When the alarm sounds, a message box
will pop-up alerting you to the starting or ending time of the item.    The alarm will chime 
every 60 seconds until you acknowledge it.    You will be asked if you would like the alarm 
repeated, and if so, when. 

To set an alarm, click on the Alarm check box (or press ALT+A) in the Insert/Refine item 
dialog box. This will place an X in the check box, to show that the alarm is now on, and will 
also bring up the Alarm dialog box.    In the Alarm dialog box, you have the opportunity to set
the alarm to go off either before or after an item is scheduled to begin, or before or after an 
item is scheduled to end.    You can also indicate the amount of time (up to 99 minutes) 
before or after the item that you would like the alarm to go off. 
 
If the "Begin time" box is marked with an "X", the alarm will sound before (or after) your 
item is scheduled to begin.    Click on the check box to remove the "X".    Click a second time 
to replace it.    You may elect to have both the "begin time" and "end time" boxes marked so 
that the alarm will go off twice, both before the item begins and before the item ends (or 
after, if "After" is selected).    
 
Selecting "OK" will set the alarm with the information you have given it and bring you back 
to the definition dialog box.    Select "OK" again and the item will appear on your schedule 
with "-a" after it.    This indicates that    the item has an alarm set.    An item followed by "-ar" 
indicates that the alarm has gone off and has been set to repeat again later today.    An "-ax"
indicates that the alarm has gone off and will not be repeated today.
 
In the Alarm dialog box pressing ESC will cause the changes just entered to be cancelled,    
however, the alarm will still be set.    Selecting "Cancel" will    have the same effect.    
 
To disable the alarm, you can delete the "X" from the check box to the left of the "Alarm" 
command button in the main dialog box.    Do this either by clicking on the check box or by 
putting the cursor next to the check box with the TAB key, then pressing the SPACEBAR.

The alarm sound may be tested by setting Alarms Off and then back on again    This is done 
in the Options menu.



Recurring Items

If you have an item that occurs on a recurring basis, it is not necessary to go to each date to
insert the item. While working in the definition dialog box, simply click on the "recurring" 
command button or press ALT+R. This will bring up another dialog box in which you may 
designate how often and on which days you'd like the item to appear on your schedule.

The following topics explain the options in the "Recurring" dialog box. Once you have 
finished your session in the "Recurring" box, click on "OK" (or TAB to the OK    button and 
press ENTER).    This will return you to the definition dialog box.    The "Date" button no longer
contains a date but is marked "Recur'ng".    On your schedule the item will be followed by "-r"
to indicate that it is a recurring item. 
 
Note: While working in the "Recurring" dialog box, you may decide that you don't want your 
item to be recurring. Press ESCAPE (or TAB to the "Cancel" button and press ENTER).

Unlike most scheduling programs, 1Soft schedulers allow you delete or change all 
occurrences (instances) of a recurring item in a single operation, so you don't have to delete 
each and every occurrence one by one. The Delete All Occurrences command is in the Edit 
menu, and its shortcut is CTRL+DELETE.

Recurring Daily
Recurring Every __ Days
Recurring Weekly
Recurring Every __ Weeks
Recurring Monthly
Ordinal Weekdays
Recurring Every __ Months
Recurring Annually
Entering Birthdays
Recurring to Non-recurring
Delete All Occurrences
Exceptions to Recurring Items
4-4-5 Quarterly Calendar



Recurring Daily

When the "Recurring" dialog box first comes to the screen, the "Daily" option button is 
selected.    Click on, or press TAB to move from the "Daily" button to the text box titled 
"Starting".    The date in this box will automatically be the date of the schedule you are 
presently working with.    You can change this date to a later date by entering it as 
"month/date/year".      
 
Click on, press TAB again to move to the text box titled "Ending". This text box will be blank, 
and if left blank will cause your item to be inserted into every daily schedule indefinitely.    
You may type in the date of the last day that you would like your item to take place.    Click 
on "OK," or press TAB to select the "OK" command button and press ENTER. The "Recurring" 
dialog box will disappear and the definition dialog box will return to the screen.



Recurring Every __ Days

Your item may not need to take place daily but every so many days.    When in the 
"Recurring" dialog box, click on (or press the DOWN or RIGHT arrow key to select) the button
labeled "Every ___ Days".    You may chose to keep the default setting (2) or you may enter 
any number up to 99.    Press TAB    to bring the cursor to the text box and type in the 
numerals. 
 
Specify "Starting" and "Ending" dates as with Daily items and press ENTER when you are 
finished.    Remember that leaving the "Ending" text box blank will cause your item to be 
scheduled into the future indefinitely. 



Recurring Weekly

To schedule a weekly item, in the "Recurring" dialog box, click on the "Weekly" button, then 
click on the check box for each day on which you want the item to be scheduled. 
 
If you are not using a mouse, press the DOWN arrow key twice to select the button labeled 
"Weekly", then TAB to the series of seven check boxes labeled for the days of the week.    
The cursor will appear as a gray vertical line to the right of the check box labeled "M".    Press
the space bar to fill in this box with an "X."    Press the RIGHT (or LEFT) arrow key to move 
the cursor along the row of boxes. 
 
You may also choose to leave all the day-of-the-week check boxes blank and tab directly to 
the "Starting" text box.    This will cause your item to be scheduled once a week on the week-
day that your "Starting" date falls on.    For example, if the "Starting" date falls on a Monday, 
then your item will be scheduled each week on Monday. 



Recurring Every __ Weeks

To schedule an item at an interval of every two or more weeks, click on (or use the DOWN 
arrow key to select) the button labeled "Every ___ Weeks".    The default setting here is 2.    
You may enter any number up to 99.    Note: Entering the number "1" in this text box will 
cause the button selection to change automatically from "Every _1_    Weeks" to "Weekly".      
 
As with Weekly recurring items, you may check the boxes to indicate on which day(s) of the 
week the item will occur.    As stated earlier, if you chose to leave all of the day-of-the-week 
boxes unchecked, your item will be scheduled on the day of the week that the "Starting" 
date falls on. 



Recurring Monthly

Items may be scheduled once, several or many times each month.    In the "Recurring" dialog
box, click on (or press the DOWN arrow key to select) the button labeled "Monthly on...". 
 
Using a mouse, simply click on "Cardinal Month Days", then click on the check boxes for 
each of the desired days. 
 
Without a mouse, press TAB to select "Cardinal Month Days".    Press TAB to move the cursor 
down to day "1" in the calendar. The cursor is now a dotted gray outline around the check 
box. Mark the boxes you wish by pressing the SPACEBAR.

Using "Cardinal Month Days", if all the check boxes are left blank, the item will be scheduled 
each month on the same day of the month as the "Starting" date. 



Recurring on Ordinal Weekdays

You may want to schedule your item to take place on a certain day each month; for example,
the first Friday and the second Wednesday of every month.    To do this, select "Monthly 
on..." and click on the button labeled "Ordinal Weekdays" (or press ALT+O).    You can move 
around this calendar and mark the boxes in the same way as with "Cardinal Month Days".



4-4-5 Quarterly Calendar

While the traditional quarter begins on the first day of the first month of the quarter, in the 
4-4-5 system, the quarter begins on the first day of the first week of the quarter. The first 
month of the quarter always has 4 weeks, the second month 4 weeks, and the third 5 weeks.
4-4-5 quarterly calendars are popular because of their uniformity. 

Many companies make frequent use of the 4-4-5 system to schedule recurring meetings. 
Here are a few examples:

1)    Meeting on the 4th Wednesday of each month
2)    Meeting on the 2nd Tuesday of each quarter
3)    Meeting on the 7th Friday of each quarter.

1)    Use as a starting date the first day of the first quarter you want to schedule it. Then 
choose every month, 4th Wednesday.

2)    Use as a starting date the first day of the first quarter you want to schedule it. Then 
choose every 3 months, 2nd Tuesday.

3)    Use as a starting date the first day of the second month of the first quarter you want to 
schedule it. Then choose every 3 months, 3rd Friday.

If you don't know the first day of a particular 4-4-5 month or quarter , you can simply enter 
the first day of the corresponding traditional month and it will be converted.

To have Month at a Glance, the pop-up Calendar, and the Extended Outlook (13 week 
printout) appear in 4-4-5 format, select Options: Calendar: 4-4-5.    To toggle this option off, 
simply select it again.

In addition, with the 4-4-5 calendar option selected, the following information is displayed on
each Sunday in Month-at-a-Glance:    The number of the week (1-52) is shown in parenthesis.
Then the month and number of the week within that 4-4-5 month is shown.    For example:    
"(50) Dec:3" indicates that    the week is the 50th week of the year; and the third week of the
4-4-5 month of December.



Recurring Every __ Months

To schedule an item at an interval of every two or more months,    in the "Recurring" dialog 
box, select the button marked "Every ___ Months...". The change the default setting of 2, 
click in, or press TAB to move the cursor inside the text box. 
 
As with Monthly recurring items, select the desired "Cardinal Month Days" or "Ordinal 
Weekdays". 



Recurring Annually

To schedule an item once a year, in the Recurring dialog box select the button labeled 
"Annually".          
 
Click on (or press TAB to move the cursor to) the "Starting" and "Ending" text boxes.    Fill in 
the dates of your choosing and click on "OK", or press ENTER.    The item will be scheduled 
each year on the date entered in the "Starting" text box.



Entering Birthdays

To enter birthdays use "Insert note item".    Enter the desired text, then click on "Recurring".   
In the recurring dialog box, choose "Anually".    Specify "Starting Date" as the next 
occurrence of the birthday; NOT the actual birthday.    The reason for this is that    the actual 
birthday may be outside of the range of Above & Beyond dates.



Recurring to Non-recurring

To change a recurring item to a single-occurrence item, in the definition dialog box click on 
(to remove) the "X" from the check box to the left of the "Recurring" button.    Without a 
mouse, TAB to put the cursor on the right side of the check box, and press the SPACEBAR. 
Each time you click on the check box or press SPACEBAR, the recurring status of the item 
switches, from recurring to non-recurring and back again.    An "X" in the check box indicates 
that the item is recurring, while an empty check box indicates that the item is a single-
occurrence item. 
 
When you change the status of an item to non-recurring this way and then press OK, all 
occurrences of the item will be deleted with the exception of the one instance that is 
selected. 



Delete All Occurrences

There are two methods you can use to remove all occurrences of a recurring item.    The first 
is to select any occurrence of a recurring item on any schedule, then select "Delete All 
Occurrences" from the Edit menu.    
 
The second method is to first choose the "Alphabetical Items List" in the View menu (ALT+V, 
A), select the recurring item on the list, press the DELETE key. 



Exceptions to Recurring Items

Perhaps a meeting which is normally scheduled to take place on the first Monday of every 
month will be moved to the following Tuesday because of a holiday that Monday.    Or 
perhaps your daily lunch, normally at 12:30 needs to be extended next Friday to 90 minutes 
and moved to 12:00 for an achievement awards luncheon.

There are quick and easy ways to make exceptions; but first, an overview: Simply select any 
standard instance of the recurring item on any schedule day and bring up the definition 
dialog box by pressing ENTER or by double-clicking on the item.
 
Now, click on the Next button (or press ALT+N) to advance the date shown above the Next 
button to the date of the next occurrence of the item.    Similarly, click on the Prior button (or
press ALT+P) to display the date of the previous occurrence of the item.    When the date of 
the item occurrence that you wish to modify is showing, you may...    
 
            Press ALT+C      --    To    Cancel (delete) this occurrence of the item or...

            Press ALT+X      --    To    indicate that this occurrence of the item
is different in some way, then... 

              
Make the desired changes in the upper portion of the definition dialog box and select OK.    
The schedule for the date of the modified occurrence will appear on the screen. To the right 
of the item title will be an "-rx" to indicate that this is an exception to a standard recurring 
item. 
 
Note:    If you would like the modifications entered to become the new standard for the 
recurring item press ALT+S (for Standard)    while still in the definition dialog box. 

To quickly Cancel (Delete) ONE instance of a recurring item, select that item in the schedule 
on day you want it cancelled. Then press delete.

To quickly change the date of one instance of a recurring item, select the instance, and 
simply move it to another day. 

To quickly change the duration (or any other details) of one instance of a recurring item, 
select the instance and press ENTER (or double click on the item.)    When the Refine dialog 
box appears, press ALT+X (or click on the Exception option.)    Change the information and 
press OK.

When the Standard (ALT+S) option is on, changes in the Refine dialog box affect all standard
instances.
Changes in the Recurring dialog box (daily, weekly, etc.) affect only the standard instances.



Changing Item Information

To change any information for an existing item, first double-click on the item description line 
on the schedule window (or select the item and press ENTER).    Then, click on (or TAB to) the
appropriate box and enter the changes.    If the desired changes are to the "Recurring" or 
"Alarm" settings, select these dialog boxes by clicking on "Recurring" or "Alarms".

To save the changes select OK.    To return the item to the schedule without any of the 
changes taking effect, press ESCAPE or click on "Cancel" (or TAB to "Cancel" and press 
ENTER).    

To make changes to a recurring item, select any STANDARD instance of the item.    If you 
select an instance of the item that has been designated as an exception, then the changes 
will only affect that occurrence of the item. 



Deleting Items

Click once on the item in the schedule (or use the arrow keys) to select it, then press the 
DELETE key (or press ALT+E, D).    A message will appear, asking you to confirm the delete 
command.    Click on "Yes" (or TAB to "Yes" then press ENTER) and the item will be removed 
from the schedule.    If you click on "No" (or press ENTER with "No" selected) the item will not
be deleted. 



Juggling Items

Once an item is inserted into your schedule, you may move it to a different position within 
that schedule or move it to the schedule of a different day.    If you are not using a mouse, 
see "The Juggle Menu" in the Menu Commands section, or pull-down the Juggle menu and 
you'll see the keyboard-equivalent shortcuts. 
 
Using a mouse, click to select the item you wish to move, then simply drag the item up or 
down within the schedule. When you move a "floating" item up or down on the schedule, the
begin time of the item will adjust automatically. Even if you have designated an item to take 
place at a fixed time, it is possible to move that item up and down in sequence on the 
schedule, however the time you specified remains the same. 
 
To move a selected item to another schedule, simply click with the right mouse button on 
the desired target date in the pop-up calendar. This is the quickest and easiest way to 
reschedule an undone item to another day.
 
Or, while viewing multiple schedules, drag the selected the item from one schedule window 
to another. 



Highlighting an Item

For emphasis, you may wish to highlight certain items on your schedule. Highlighted items 
appears in the schedule as underlined and will be printed when "Extended Outlook" is 
selected.    See the Print commands in the File menu for more information on the Extended 
Outlook. 
 
The "Highlight Item" command will underline the currently selected item.    A shortcut for this
command is to press F3 while in the schedules window.    Press F3 again to remove the 
underline.    Items you wish to appear in the "extended outlook" Month-at-a-glance view 
must be highlighted.



On Screen Views

One to seven schedules can be viewed on screen simultaneously.    The schedules may be 
stacked    vertically, or tiled horizontally.    You may also view a list of all items, either ordered 
by priority, or alphabetized on item title.    These view options and others such as Month at a 
Glance are selected in the View menu.    For more information, see The View Menu in the 
Menu Reference Section.



Printed Schedules

You may print reports that list your schedule for the present day and beyond;    plus a three 
month calendar. This allows you to see openings for appointments while away from your 
computer. All highlighted (underlined) events for the next three months also may be listed 
by choosing the Extended Outlook option. See the Print commands in The File Menu section 
for details. 

Printed schedules have vertical spacing proportional to time span.    This makes it easier to 
see the relative durations of each item.    Items of longer duration will have more blank space
below the row they appear on, than those of shorter duration.



Notes

Notes of varying lengths can be attached to items. They may also be printed.    For more 
information on notes, see Edit: Notes in the Menu Reference Section.



The Toolbar

Just below the Above & Beyond banner line is a toolbar which contains icons for quickly 
accessing a variety of commonly used commands.    Note: To remove the toolbar from view, 
click on the small upward pointing triangle just above the vertical scroll bar.    To restore the 
toolbar, click again.

Select: Prior Week

Select: Prior Day

Select: Today's Schedule

Select: Next Day

Select: Next Week

View: Single Schedule Window

View: Week at a Glance

View: Month at a Glance

View: Alphabetical List

View: Priority List

Select: Search

Options: Calendar: Open

Worktools: Timer

Worktools: Autodial

View: Browse Notes

Edit: Notes



Edit: Start Item

Edit: Item Done

Edit: Delete Item

Juggle: Carry Over Undone Items

Juggle: Balance Workload

File: Print: Today's Schedule



Data Saving and Backups

To minimize data loss from unexpected natural disasters such as power interruptions, 
schedule changes are saved every 60 seconds in your data file which has the .PAK 
extenstion.    As an added precaution,    a backup file is maintained which contains your 
previously saved scheduling data.    It has the extension .BAK.

There are few things more important than your data.    Especially the scheduling data you 
rely on to plan your future and to track your accomplishments.    On a daily basis make 
backups of    all *.PAK files as well as your archived schedules (*.LOG files). These backups 
should be made on reliable media and stored in a safe place. 



Schedule Archiving

A schedule will be automatically "archived" seven days after all items on that day have been
either marked done, rescheduled, carried forward, or deleted. That is, nothing remains on 
the day, but items marked done. Those completed items are archived to monthly log files 
named according to the month and year.    For example: "Jan91.Log"    Note: In order to 
conserve RAM, there is an exception to the seven day wait:    If you have more than 300 
items (total) in Above & Beyond, archiving will occur one day after all items on the day have 
been done.

To view the archived schedules for a particular month, select any schedule in that month; 
then choose View: History for Month.    (See Selecting Schedules for more information on how
to select schedules.)    The archive files are ASCII format (text) and may also be displayed or 
printed using the TYPE or PRINT commands of DOS, Windows notepad, or other utility 
applications, including text editors.

If you wish to view or print a log file which contains all currently completed items, use the 
Archive Completed Schedules command in the Options menu.    This will archive all done 
items, even those that were marked done less than seven days ago.    To print the log file 
select View: History for Month and then select File: Print in the notepad.

Log files are formatted with tab-separated values so they can also be read as text files by 
spreadsheets such as Microsoft Excel and Lotus 1-2-3.    To make it simpler for you, durations 
are in one type of units: minutes.



Automatic Launch of Applications

There may be times when you want to run a program or application at a precise time 
without having to manually initiate it.    This feature is activated by either of the two 
keywords, "Exec" or "Autoexec".    When either one of these words is included in the item 
title the feature is enabled.    You may specify parameters which will be passed to the 
program.

When the keyword "Exec" is used, and the scheduled begin time for that item is reached, a 
dialog box will be displayed which has the current time and the message, "Ready to Exec 
<program name>?"    At that time, choose "yes" to run the program, or choose "no" to 
cancel the process.

When the keyword "Autoexec" is used, and the scheduled begin time for that item is 
reached, the program will automatically be run without waiting for you to reply to a prompt.
 
If you would prefer that Exec or Autoexec not mark the item done, but "Start" the item 
instead, simply enter the keyword in lower case ("exec" or "autoexec").    For details on the 
Start Item command see Edit: Start Item in the Menu Reference section.

You can manually launch an Exec or Autoexec item prior to its designated begin time.    
Simply select the item, then press F5 (or use Edit: Start Item).

Both Windows and non-Windows programs, plus batch and command files may be run using 
these commands. If the program is a Windows application, the program window will appear 
in front of any other active windows and will have the focus. If it is a non-Windows program, 
the system will automatically switch to the DOS environment to run it. When the program 
ends, the system will switch back into the Windows environment. 
 
Note: Unless you specify the path explicitly (e.g.    Exec    c:\mydir\backup.bat),    the PATH 
statement in Autoexec.BAT must include the directory in which the program or file is to be 
found.
    
The format for an Exec or Autoexec item title is: 
 
<Description>    <Keyword>    <Program name>    <Parameters> 
 
<Description> is any text.
<Keyword> is either    Exec, exec, Autoexec, or autoexec.
<Program name> is the    name of the program or executable file you want Above & Beyond 
to load and run.    Programs and executable files must end in either .EXE, .BAT, .COM, or .PIF.
<Parameters> are any information that the program needs to perform.

All of the four parts above are optional.    For example, you may want to use the keyword 
"Autoexec" with no program name to simply have an item (e.g. "Lunch") automatically 
marked as done.

The description, keyword, program name and parameters are all typed into the Title line in 
the definition dialog box used to create the item, and they will be displayed on the schedule 
in the normal fashion.
The keyword, program name and all parameters must be separated from each other by 
(only) one space.    

Note: When running in a LAN environment and viewing someone else's schedule, you may 



temporarily disable their Exec and Autoexec launching by choosing Options: Alarms Off.    
Note that the setting you select for this option on their Above & Beyond schedule affects 
only your viewing of their schedules.    That is, Exec and Autoexec will still be functional 
when they view their Above & Beyond schedules from their workstation.

Exec Sample Item:

Backup    manuscript    Exec    C:\mydir\mybackup.bat    B: 
 
In this example, the description of the function you want to accomplish is "Backup 
manuscript".    The keyword Exec instructs Above & Beyond to prompt you before it loads 
and runs the batch file.    This will give you time, for example, to put a blank diskette into the
drive.    "mybackup.bat" is a batch file you created to make backup copies of the manuscript. 
You wrote the batch file so that it would copy onto any disk drive you specify.    Here, you 
have specified the parameter "B:",    indicating that you want to use drive    B:    this time. 

Autoexec Example:

Autoexec    Notepad
 
In this example, there is no descriptive text.    You chose the keyword    Autoexec    this time 
because this is a high priority item and the program must run at the specified time.    
Notepad is the name of the program that will be run, and it requires no parameters. 



Workgroup Use

Summary of Features

1.    You can view and update the schedules of other Above & Beyond users.    Note, however,
that these schedules must be in directories to which you have read and write access.    One 
or more of these schedules can be based on local area network (LAN) servers.    Multiple 
schedules can be viewed on your screen in overlapping windows. 

2.    You can delegate items easily by "cutting" items from your schedule and "pasting" them 
into the schedules of co-workers.    

3.    You can check on the status of items being performed by others in the group.    If the 
item is completed you'll see it marked done; if it is coming up, you can see when the person 
plans to get to do it.

4.    You can easily schedule meetings when a group of others (and yourself) are available.    

5.    You can post electronic mail by inserting notes into another person's schedule.
 
6.    A common company phone book may be created which can be accessed by every Above
& Beyond user.    If the company phone numbers are stored in a cardfile named "phone.crd" 
then simply add the following entry to each user's Worktools list:

Company Phone Book cardfile.exe phone.crd

7.    Users can be restricted for viewing and/or changing the schedules of other users.    This 
is done by setting passwords for the various levels of access.    See Options: Set Passwords.



Opening Schedules

In order to look at or update the schedules of others, you must first "open" the user; which 
means that their schedules will appear on your screen.    A list of the "open" users is 
displayed in the Schedules menu.    For instructions on how to "open" users, see the section 
on the Schedules menu .



Workload Management

Supervisors who assign work can monitor and adjust the workload and priorities of each 
worker in a precise way.    Above & Beyond schedules show clearly the workload on each day,
in percentages, amounts, and even graphically with use of color on the pop-up calendar. 

Supervisors know ahead of time when a worker is running out of things to do, or on the other
hand, if too much work is piling up.    Supervisors can see when workers will be getting to 
particular items, and shift the work sequence based on new priorities.



Status Query

Supervisors can check the completion status of any item at any time, without interrupting 
the worker. The worker doesn't even have to be available, which is important if they are 
working at another location, at lunch, on the phone, out sick, or on another shift. This is an 
enormous time saver. If the supervisor finds the item has not been completed, he can also 
see when the worker has planned to get to it.



Passwords

Users can be restricted for viewing and/or changing the schedules of other users.    This is 
done by setting passwords for the various levels of access.    For more information See 
Options: Set Passwords in the Menu Reference section.



Meeting Maker

Meetings for several Above & Beyond users can be planned jointly. The cost of trying to find 
out when everyone in the group is free is normally quite high, because of the amount of time
it takes to interview each person in the group and have them check their schedules, and 
recheck their schedules for alternate slots. That hassle is eliminated with the Meeting Maker 
because anyone with access to all the schedules needed can plan a meeting that is conflict-
free. When a joint meeting is scheduled, the item is posted on the schedules of each of the 
attendees. 

The Meeting Maker feature will find blocks of free time which are common to all Above & 
Beyond users whose schedules are currently open on the screen of the person who is 
scheduling the meeting.    The Meeting Maker will display a list of the users who are open in a
box labeled "Attendees".    For information on how to "open" selected users, see the section 
on the Schedules menu.
 
Enter the title of the meeting as you would like it to appear on the attendees schedules.    
Enter the duration of the meeting if different from the default duration.    Select the 
appropriate check boxe(s) for the day(s) of the week that the meeting can occur.      
 
The "Search Bounds" are the time constraints for when the meeting can be scheduled.    The 
"Start Date" is the earliest date that the meeting could be scheduled.    Enter the desired 
search bounds and start date if different from those shown. 
 
When the "Search" command is selected, Above & Beyond will search the attendees 
schedules for a block of free time of the specified duration, between the search bounds, and 
after the start date.    The first potential meeting date will appear in the box below the 
"Search" command button.    The block of free time which is common to all attendees on that
date will appear in the "Open Range" box.    A suggested begin time will appear in the "Begin
Time" box.    If the open range is longer than the meeting duration, you may specify an 
alternate begin time within the open range. 
 
If the first potential meeting date and open time range is not to your liking, simply select the
"Next" command.    Above & Beyond will search for the next block of free time (of the 
duration specified) which is common to all attendees.    To return to the first potential 
meeting date select the "Search" command again. 
 
When the suggested meeting date and begin time is to your liking, select the "Schedule" 
command and the meeting will be added to each attendee's schedule.    To exit the Meeting 
Maker select    the "Exit" button. 



The Alarms Off Option

When running in a LAN environment and viewing someone else's schedule, you will see their
alarms pop up.    To prevent this, choose "Alarms Off" in the Options menu.    This tells Above 
& Beyond to display only your alarms.    The setting you select for this option on their Above 
& Beyond schedule affects only your viewing of their schedule.    Alarms will still pop-up 
during their Above & Beyond sessions.    This setting is remembered between sessions, so 
you need only issue this command once.



The File Menu

Print
Choose Fonts
Page Size Setup
Control Panel
Import
Export: Today's Schedule
Export: Range of Schedules
Name
Save
Exit
About Above & Beyond



File: Print

Today's Schedule
Viewed Schedule
Range of Schedules
Extended Outlook
Priority List
Open Notes



File: Print: Today's Schedule

This command    will print the current day's schedule, regardless of the schedule appearing 
on the screen. 

You will be asked if you would like to also print a Four Week Outlook.    This consists of a 
calander showing fixed schedule items with their begin times.



File: Print: Viewed Schedule

This command will print the schedule currently being viewed on the screen.    You will be 
asked if you would like to also print the Four Week Outlook.    This consists of a calendar 
showing fixed schedule items with their begin times.



File: Print: Range of Schedules

The Print Range of Schedules command allows you to print out a number of schedules 
between specified dates. 
 
Selecting this command will bring up a dialog box into which you can enter the range of the 
schedules you wish to print.    You can also choose options such as the number of schedules 
that will appear on a page and if you would like the Extended Outlook and/or Notes printed 
as well. 

In the first area of this dialog box, select the option button labeled "Today" (the present date 
appears to the right of this button) or the option button labeled "Date:" and enter the date of
the first schedule you would like printed. 

In the second area, you may choose how many schedules you would like printed.    Select the
first option button and enter the number of days (schedules) to be printed; or select the 
option button titled "Date:" and type in the date of the last schedule to be printed. 
 
The next area of the dialog box is where you may indicate how many schedules to be printed
per page.    Select the first option button and enter the desired number of schedules per 
page; or select the second option button to have the schedules fill the entire page. 
 
Check the box titled "Extended Outlook" if you would like to print a three month calendar 
showing highlighted items for the next three months.    Check "Notes" to print the Notes for 
the items.



File: Print: Extended Outlook

The Extended Outlook consists of a list, and a calendar showing highlighted items for the 
next three months.    See View: Month at a Glance for more information on how to enter 
items so that they appear correctly in the Extended Outlook.



File: Print: Priority List

This command will print the list schedule items ordered by priority.    Select "First Page" to 
print just the highest priority items.    Select "All Pages" to print the entire list.



File: Print: Open Notes

This command will print all notes that are currently "open."    To open a note, simply select 
the schedule item that is associated with the note, and press Control+E (or choose Edit: 
Notes).    To close a note, select "close" in the note window control menu (Alt+Spacebar, C).



File: Choose Fonts

You can select different fonts for viewing on screen and for printouts.    For printouts you can 
choose different fonts for "Normal text" and "Headings".

For on screen, you can choose different fonts for when schedules are displayed in a Single 
Schedule Window, and when displayed in Multiple Schedule Windows such as Week at a 
Glance.    In addition, you may select a special font for the schedule headings.



File: Page Size Setup
 
For printed output, use Page Size Setup to select from a variety of    page height and width 
options.    For example, for Daytimer's appointment books, use 6.75" by 3.75".    Select "Extra
Wide Left Margins" when using paper with pre-punched holes along that margin.    Select 
"Centered" when using non-standard sized paper in the manual feed slot of printers such as 
Laserjets.

If you choose "Full", the settings from the current printer setup are used.    These are 
selected in the Windows Control Panel which    may be accessed with the File: Control Panel 
command.



File: Control Panel

Use this command to quickly access the Windows Control Panel, for example, to set printer 
options.



File: Import 

Schedule items can be imported from the file IMPORT.TXT into Above & Beyond.    Each line 
of the file should be in the following format:

<date>    <begin time>    <duration>    <title>

Use one space (no tabs) between the four parts.    Everything but the title is optional.

For the many acceptable formats for date, begin time, duration, and title, refer to Inserting 
Items Into a Schedule.    For date format see Entering Item Date.    For begin time format see 
Begin Time and Floating Fixed.    For duration format see Entering Item Duration.    For title 
format see Entering Item Title.



File: Export Today's Schedule

This command will cause the present day's schedule to be written to a file called 
EXPORT.TXT in the current directory.    To easily view this file select View: Export File.



File: Export Range of Schedules

This command will allow you to print a number of schedules to a file entitled EXPORT.TXT in 
the current directory.    To easily view this file select View: Export File.
 
Selecting the Export Range of Schedules command will cause a dialog box to be displayed 
on the screen.    In the first area of this dialog box, select the option button labeled "Today" 
(the present date appears to the right of this button); or the option button labeled "Date:" 
and enter the date of the first schedule to be printed. 

In the second area, you are able to choose how many schedules you would like exported.    
Select the first option button and enter the number of days for the number of schedules to 
be exported; or select the option button titled "Date:" and enter the date of the last 
schedule to be exported. 
 
The next area of the dialog box is where you can indicate to number of schedules to appear 
on each page; or select the second option button to have the schedules fill the entire page. 
 
Check the box titled "Extended Outlook" if you would like to include a three month calendar 
with a list of up-coming highlighted items for the next    three months. 
 
Select the "OK" command button to have the schedules exported. 



File: Name

The Name command will display on the screen the name of the file where the schedule 
information is stored. This is helpful when you have the schedules of several users active on 
the screen at one time. Using this command, you will be able to verify whose schedule you 
are looking at in cases where the person has not entered their name in the banner line.    



File: Save

The Save command will save any changes made during the last minute to the TIMEDATA.PAK
file.    However, since changes are saved automatically every sixty seconds, you need not 
use this command. 



File: Exit

The exit command will do a File: Save and return you to the Windows Program Manager.



File: About Above & Beyond

This command will display information about the program including copyright information 
and version number.



The Edit Menu

Insert Schedule Item
Insert Memo Item
Insert Done Item
Refine Item
Delete Item
Delete All Occurrences
Arrange a Meeting
Duplicate an Item
Edit Notes
Item Done
Fluid Item
Highlight Item
Private Item
Schedule Item
Start Item
Item Done Now
Item Done Now, Fit To Gap
Start Item After Last
Fit to Gap
Append Time & Date Stamp
Cut
Copy
Paste



Edit: Insert Schedule Item

Use this command to enter new items into your schedule.    A shortcut for this command is to
press "Insert". A dialog box will appear in which you can enter specific information about 
your item.        
 
When you have completed your session in the definition dialog box, select the "OK" 
command button and the item will be inserted into the schedule. 
 
To learn more about inserting new items and the definition dialog box, see the section 
entitled Inserting Items into a Schedule.



Edit: Insert Memo Item

This command will bring up a definition dialog box for entering a memo item into your 
schedule.    Enter the text of the memo and select "OK".    The item will be labeled "memo" 
and will not conflict with scheduled items nor be calculated into the workload by the color 
utilization calendar. A shortcut for this command is to press ALT+INSERT.



Edit: Insert Done Item

For those times when you want to record something you did that wasn't planned, press F10; 
or choose Edit: Insert a Done Item.    This is a shortcut for inserting an item, editing the begin
and end times, and marking it done.    Default values for the begin and/or end time are used 
unless they are modified by being overtyped.    The default begin time is the end time of the 
previously done item.    The default end time, is the current time.    See also Edit: Item Done 
Now 



Edit: Refine Item

The Refine Item command will allow you to change previously entered information for the 
currently selected item.    A shortcut for this command is to press ENTER or double-click on 
an item in the schedules window.    
 
Selecting this command will open the dialog box which contains the information regarding 
this item that you entered previously.    When you have made the desired changes to the 
data in the dialog box, select "OK". 



Edit: Delete Item

The Delete Item command will remove the currently selected item from the schedule.    A 
shortcut for this command is to press DELETE while in the Schedules window. 
 
If the item you have selected to delete is a recurring item, the "Delete Item" command will 
only remove the item from the schedule you are currently viewing.    To remove all 
occurrences of a recurring item, use the "Delete All Occurrences" command; or delete the 
item from the Alphabetical Items List. 



Edit: Delete All Occurrences

The Delete All Occurrences Item command will remove all instances of a selected recurring 
item from all schedules.    A shortcut for this command is to press CONTROL+DELETE while in
the schedules window. 



Edit: Arrange a Meeting

For details, see the The Meeting Maker in the section entitled "Workgroup Use". 



Edit: Duplicate an Item

The Duplicate Item command will insert a duplicate of the selected item into the schedule 
directly below the selected item.    Shortcut: press double-quote (") while in the schedules 
window. 



Edit: Notes

To attach a note to any schedule item, choose Edit Notes from the Edit menu, or use the 
shortcut Ctrl+E. Once a note has been created a note icon will appear to the right of the 
item's description on screen. Double click on the icon to view or edit the note.    Another 
method is to use the icon in the toolbar.    This is especially convenient when the righmost 
portion of the schedule window is covered by another window, such as the pop-up calendar.

Navigating in a note is fast and easy. You can use the keyboard, exclusively, or use it in 
combination with the mouse. To move to the end of a note, use Ctrl+End. To move to the 
beginning of a note, use Ctrl+Home. Any areas of text can be selected and cut or copied and
pasted to any other Windows application. You can also paste in text from other Windows 
applications.

If you wish to delete the entire text of a note, select the text and then press "Delete".    (To 
select the entire text, place the cursor at the beginning of the text and press 
"Shift+Control+End").

Time and date stamping is available from the control menu.    The shortcut is Ctrl+D.

Also in the control menu of each note is a word & character count command which displays 
the number of words and characters in the text of the note.    If some portion of the text is 
selected, the count will be just for the selected portion.

"Open" notes many be printed by selecting File: Print: Open Notes.    Notes are "open" until 
they are closed by pressing Alt+F4, or by selecting "Close" in the note window control menu.
If View: Browse Notes is selected, the only "open" note will be one attached to the currently 
selected item.    This enables you to quickly move from item to item viewing the notes 
associated with each one.

Sharing Notes

Sometimes you may wish to share a note between two items. If you duplicate an item, the 
duplicate item references the same note.    This is very convenient for many purposes, such 
as notes in preparation for a phone call. Insert a schedule item for making the first call, then 
create a duplicate item and reschedule it for the follow-up.    The follow-up call item will 
automatically reference the notes made in preparation for the first call, plus any results that 
you noted there.

Where Your Notes Are Stored

You may not care to know where your notes are stored, because they are so easily accessed 
from Above & Beyond. But here are the details if it interests you.

Notes are stored in a subdirectory NOTES from the directory that contains your data (.pak) 
file. Each note has a filename created from a 3 letter prefix and 5 digit number. The prefix 
will be the same for each note you create for any given data file. The note file prefix is 
generated randomly when a new data file is created. 

There are also two subdirectories of note files.    When a done item is archived, any attached 
note that is unshared is moved to the NOTES\ARCHIVED subdirectory.    When you delete an 
item that has an unshared note attached, that note file is moved to the NOTES\DELETED 
subdirectory.





Edit: Item Done

To indicate that the selected item has been done, simply press the SPACEBAR.    A done item 
appears with a line through it.    The begin time is automatically set to immediately follow 
the end time of the previously done item.    To change the item back to undone, simply press 
the SPACEBAR again.

Items on future days cannot be marked done.    Instead, move the item to the day it was 
actually done, and then check it off.

Past schedules will be automatically archived seven days after all items have been marked 
as done.

See also, the Edit menu commands Item Done Now and Item Done Now, Fit To Gap.



Edit: Fluid (not Firm) Item

This command will toggle an item from Fluid to Firm, and vise versa.    The shortcut for this 
command is ALT+F2.    For a brief summary of Fluid items, see the section titled Firm / Fluid.   
For an in-depth discussion of Fluid and Firm items, see the section titled Workload Balancing.



Edit: Highlight Item

The "Highlight Item" command will cause the selected item to be underlined.    Using this 
command on an item that is already underlined will remove the underline from that item.    A
shortcut for this command is to press F3 from the schedules window. 



Edit: Private Item

You may desigante certain schedule items as "Private".    Private items can be viewed only if 
"your" password is entered.    People using your "view" or "modify" password will see that 
there is an item scheduled (and it's duration) but cannot view or modify it.

To make an item private, begin the item description with the vertical bar character ( | ).    To 
toggle "privateness" on and off, press Alt + F3 (or select Edit: Private Item).    By using the 
vertical bar as the first character of the item title, a person with your "modify" password can 
insert a private item for you.    Note, however that once entered as such, the sender will not 
be able to view or modify it.

For more information on passwords, see Options: Set Passwords in the Menu Reference 
Section.



Edit: Schedule Item

Using the Schedule Item command on an unscheduled item will make it a (floating) 
scheduled item.    If you wish to specify a particular start time for an item, use the Refine 
Item command an enter a begin time.
      
Using the Schedule Item command on a scheduled item will make it unscheduled.    This 
toggle feature makes it easy to "undo" the command if you desire.    A shortcut for "Schedule
Item" is to press F4 from the schedule window.



Edit: Start Item

With this command (shortcut: F5) the elapsed time of an item in progress can be displayed.   
The Start Item command will start recording the elapsed time associated with the selected 
item.    The elapsed time along with the duration will be displayed on the schedule line. It will
look like this: (:04/:30).    The first number is the actual elapsed time, the second is the 
originally planned duration. 
 
When the item is marked as done, the total elapsed time will be saved and archived along 
with the item.    If you accidentally hit the Spacebar, marking    an item done that is not 
actually done, simply toggle the item to undone (by hitting the Spacebar again) and the 
timing will be restored.
 
If you would like to "restart" a "done" item use the Start Item command again.    The "done" 
item will remain marked as done however a duplicate item will be created and started at the
current time. With this method you have a record of the two (or more) segments of time that
the item was worked on. 
 
The Start Item command may also be used to manually launch an EXEC or AUTOEXEC item 
earlier in the day on which it is scheduled.



Edit: Separate Note

Normally, each instance of a recurring item will share a common note.    Items created using 
the Edit: Duplicate Item command will also share a common note.    If you would like to 
attach a separate note to either of these type of items, use Edit: Separate Note.    This 
command will create a separate note for a selected item that previously had a shared note.



Edit: Item Done Now

Use this command to indicate that you just now finished the item.    Item Done Now    marks 
the item done and (if on today) sets the begin time so that the item ends at the current 
time.    If the item is on a past day, the begin time is not changed.    The shortcut for this 
command is Control+Spacebar.

Items on future days cannot be marked done.    Instead, move the item to the day it was 
actually done, and then check it off.

Past schedules will be automatically archived seven days after all items have been marked 
as done.

See also Edit: Item Done and Edit: Item Done Now, Fit To Gap



Edit: Item Done Now, Fit To Gap

Use this command to indicate that you just now finished the item, and that you began 
working on it immediately following the previously done item.    This command is equivalent 
to selecting Edit: Item Done Now and Edit: Fit to Gap.    The shortcut for this command is 
Shift+Spacebar.

In the event that you thought you were done, but then continued working on the item, select
the command again.    The duration will be extended to show that the item ended at the 
current time.



Edit: Start Item After Last

With the "Start Item" command (described above), the start time used is the time at the 
moment the command is issued.    With "Start Item After Last" the start time used is the time
when the last done item was finished.    Use this command when you wish to "start" an item 
and indicate that you actually began working on the item immediately after the previously 
done item. 



Edit: Fit To Gap

This command adjusts the begin and end time of the selected item so that the item fills the 
available time slot between the previous item and the item following.    In other words, the 
begin time is set to follow the end time of the previous item; and the end time is set to the 
begin time of the item following.    This command is useful when you wish show 100% 
utilization of your time; that is, no unaccounted-for time.



Edit: Append Time & Date Stamp

Control-D will add the current time and date to the end of the item title.    This can be used 
repeatedly, for example to record several unsuccessful attempts to call someone.

Note: This feature is designed for use anytime outside of the insert/refine dialog box.



Edit: Cut

The Cut command deletes the selected item from the schedule. The deleted item is placed 
in a temporary holding area known as the Clipboard. You can then move the item to another 
person's schedule with the Paste command.    See also Edit: Copy and Edit: Paste.



Edit: Copy

The Copy command copies the selected item to the Clipboard so that you may duplicate it 
elsewhere using the Paste command.    See also Edit: Paste.

Note: If Copy (or Cut) is used from the Schedules view, the item's date, time, duration and 
title is copied to the Clipboard.    If Copy (or Cut) is used from the Alphabetical Items list, only
the item's title is copied.



Edit: Paste

The Paste command inserts the item that is on the Clipboard to into the current schedule. In 
order for the Paste command to be available there must be some text which as been placed 
on the Clipboard via the Cut or Copy commands.

Cut, Copy andPaste are intended for use when you wish to place the item into someone 
elses schedule.    To copy an item to a different date on your schedule, use the Duplicate 
Item command and then move the duplicate item to the desired date.    See the section 
entitled Juggling Items for information on how to move items to a desired date.

Note: If Copy (or Cut) was used from the Schedules view, Paste will paste the item onto a 
schedule corresponding to the item's date.    If Copy (or Cut) was used from the Alphabetical 
Items list, you may Paste the item onto any date. 



The Select Menu

With a mouse you may select a schedule item by simply clicking on it.    To select a schedule 
for a specific date, click on the desired date on the pop-up calendar.

The commands in the Select menu allow you to use the keyboard to select specific 
schedules and schedule items for viewing, editing or juggling.

There are shortcut alternatives to each command in this menu.    The shortcuts are listed to 
the right of the commands in the menu.    Shortcuts are to be used instead of the pull-down 
menus;    so don't pull down a menu if you intend to use the shortcut keys.    Note: To close a 
pull-down menu without selecting any command press the ESCAPE key.

Prior Item
Next Item
Prior Page
Next Page
Prior Schedule
Next Schedule
Today's Schedule
Prior Day
Next Day
Prior Week
Next Week
Specific Date
Last Viewed Day
Earliest Undone Schedule
Search



Select: Prior Item

The Prior Item command will select the item above, or prior to, the item currently selected 
on the schedule.    A shortcut for this command is to press the UP arrow key.



Select: Next Item

The Next Item command selects the item below the item currently selected, or the next 
item, on the schedule.    A shortcut for this command is the press the DOWN arrow key.



Select: Prior Page

The Prior Page command will allow you to view the previous page of a schedule that is too 
long to view on one screen.    A shortcut for this command is to press the PAGE UP key.



Select: Next Page

The Next Page command will allow you to view the previous page of a schedule that is too 
long to view on one screen.    In the Select menu, select "Next Page" and press ENTER.    A 
shortcut for this command is to press the PAGE DOWN key.



Select: Prior Schedule

The Prior Schedule command selects the schedule for the date immediately preceding the 
currently selected schedule.    A shortcut for this command is to    press the LEFT arrow key.
 
If viewing multiple schedule windows, the Prior Schedule command will select the schedule 
that appears to the left of the currently selected schedule.    If the left-most schedule is 
selected, the Prior Schedule command will change the schedule in that window to the 
schedule of the previous day.



Select: Next Schedule

The Next Schedule command will select the schedule immediately following the currently 
selected schedule.    A shortcut for this command is to press the RIGHT arrow key.
 
If you are viewing multiple schedules, the Next Schedule command will select the schedule 
to the right of the currently selected schedule.    If the right-most window on the screen has 
been selected, the Next Schedule command will change the schedule in that window to the 
schedule of the next day.



Select: Today's Schedule

The Today's Schedule command will make the schedule for the present day the currently 
selected schedule.    A shortcut for this command is to press the HOME key.



Select: Prior Day

The Prior Day command will select the schedule for the day prior to the currently selected 
schedule.    A shortcut for this command    is to press the gray MINUS (-) key near the numeric
keypad.



Select: Next Day

The Next Day command will select the schedule for the day after the currently selected 
schedule.    A shortcut for this command is to press the gray PLUS (+) key near the numeric 
keypad while in the schedule window. 



Select: Prior Week

The Prior Week command will select the schedule for the day one week prior to the currently
selected schedule.    A shortcut for this command    is to press F7.



Select: Next Week

The Next Week command will select the schedule for the day one week after the currently 
selected schedule.    A shortcut for this command is to press F8.



Select: Specific Date

The Specific Date command will allow you to specify the exact date of the schedule you 
want to view. A shortcut for this command is to press F9 or simply click on the desired date 
on the pop-up calendar. 

When you select the Specific Date command, a dialog box will be displayed on the screen. 
Type in the date of the schedule you wish to view.    Dates may be entered as 
"month/day/year" using slashes, hyphens, spaces or periods.    Often the year may be 
omitted.    See Entering Item Date for more information on when the year may be omitted.

To select the schedule "n days from now" simply type in a number "n".    To select the 
schedule one week from now, type "1w".    For two weeks from now, type "2w".    For two 
months from now, type "2m".

You may also enter the name of the day of the week, or an abbreviation such as "M", "Tu", 
"W", "Th", "F", "Sa", or "Su".    To select next Monday, type in "M".    For two weeks from next 
Monday type "M2".    For three weeks from next Tuesday, type "Tu3". 



Select: Last Viewed Day

Use this command to view the schedule that was viewed just prior to the schedule currently 
being viewed.



Select: Earliest Undone Schedule

The Earliest Undone Schedule command will select the earliest schedule of uncompleted 
items that exists in Above & Beyond.    Archived schedules will not be selected.      A shortcut 
for this command is to press the END key. Remember that all items on a schedule for a past 
day must be marked as done before that schedule will be archived. 



Select: Search

This command will select the schedule items and memos which contain    a given text sting.   
The shortcut for this command is Control+S.    A dialog box is displayed in which you'll enter 
the text string to search for.    You may choose to search forward or backward in time.    If you
choose "All", the earliest occurrence of the string is displayed.    Click on "Forward" to then 
view the subsequent occurrences.    Click on "Exit" to remove the search dialog box from the 
screen.



The Juggle Menu

The commands in the Juggle menu will allow you use keystrokes to move items within a 
schedule or to different schedules. If you are using a mouse, refer to the section entitled 
Juggling Items. 

When you move a "floating" item up or down on the schedule, the begin time of the item will
adjust automatically.    It is possible to move a "fixed" item up and down on the schedule 
however the begin time you specified will remain the same.    This way you can sequence 
and/or prioritize items to your liking. 
 
If you move an item to a spot where it conflicts with another item or goes outside of the time
bounds you designated, the time will appear grayed warning you of the conflict. 

Earlier in Day
Later in Day
Prior Schedule
Next Schedule
Prior Week
Next Week
Carry Over Undone Items
Balance Workload
Shorter/Longer Duration
Earlier/Later Fixed Begin Time



Juggle: Earlier in Day

The Earlier in Day command will cause the selected item to be moved immediately before 
the item that appears above it on the schedule, i.e. earlier than that item.      A shortcut for 
this command is to press CTRL+UP arrow. 



Juggle: Later in Day

The Later in Day command will cause the selected item to be moved beneath the item that 
appears directly below it on the schedule, or later than that item.    In the Juggle menu, 
select    "Later in Day" and press ENTER.    A shortcut for this command is to press 
CTRL+DOWN arrow.



Juggle: Prior Schedule

The Prior Schedule command will cause the selected item to be moved to the previous 
schedule.      A shortcut for this command is to press CTRL+LEFT arrow.
 
If you are viewing schedules in multiple windows, the Prior Schedule command will transfer 
the selected item to the schedule on the left.    However, that schedule may    not necessarily
be the prior day.    If you are viewing multiple schedules and the item you wish to move is in 
the left-most schedule, then the Prior Schedule command will cause the schedule in that 
window will change to the schedule of the preceding day and the selected item will appear 
in that schedule. 



Juggle: Next Schedule

The Next Schedule command will cause the selected item to be moved to the following 
schedule.      A shortcut for this command is to press CTRL+RIGHT arrow.
 
If you are viewing schedules in multiple windows, the Next Schedule command will transfer 
the selected item to the schedule, or window, to the right.    If you are viewing schedules in 
multiple windows and the item you wish to move is in the right-most schedule, then the Next
Schedule command will cause the schedule in that window to change to the schedule for the
next day and the selected item will appear in that schedule. 



Juggle: Prior Week

The Prior Week command will move the selected item back to the schedule one week, or 
seven days, prior to the currently selected schedule.    A shortcut for this command is to 
press CTRL+F7.



Juggle: Next Week

The Next Week command will move the selected item to the schedule one week, or seven 
days, ahead of the currently selected schedule.    A shortcut for this command is to press 
CTRL+F8.



Juggle: Carry Over Undone Items

To move all past undone items to today's schedule, simply press F12, or select Juggle: Carry 
Over Undone Items.



Juggle: Balance Workload

When you issue the Balance Workload command, all Fluid items are rescheduled 
dynamically. Precedence is given to the items in their order of prority. This means that all 
things being equal, higher priority items will be scheduled earlier than lower priority items. 
The priority 1 item may be scheduled today, for example, and the priority 145 item may not 
come up until next month. Each Fluid item has a relative priority from 1 to 999. 

When the Balance Workload command is selected, the order of Fluid items may be 
automatically changed based on their priority, duration and the availble free time.    Fluid 
items may also be moved forward or back (between days), again based on priority and the 
best fit into available free time. The date range within which a Fluid item may flow is 
determined by the "Postpone" and "Deadline" dates that you have specified in the 
insert/refine item dialog box.    That is, it will be scheduled after "Postpone" but before 
"Deadline".    If an item must occur on a particular day (such as Friday) or range of days 
(such as Monday through Friday), these parameters are also taken into consideration.

For an in-depth discussion of Workload Balancing, see the section titled Workload Balancing 
in the Introduction to Above & Beyond.



Juggle: Shorter/Longer Duration

To quickly make adjustments to an item's duration without going into the refine screen, 
these shortcuts can be used: Control+Left subtracts one minute from the duration; 
Control+Right adds one minute.



Juggle: Earlier/Later Fixed Begin Time

To quickly make adjustments to an item's begin time without going into the refine screen, 
these shortcuts can be used: Control+Up subtracts one minute to the begin time; 
Control+Down adds one minute.



The View Menu

The options in the View menu allow you to choose how you would like to view your 
schedules: in a single window, in multiple windows or as an alphabetical list.    Check marks 
to the left of the options in the    menu show which options are currently in effect.

Single Window
Priority List
Alphabetical Items List
Multiple Schedules
Week at a Glance
Month at a Glance
Export File
History for Month
Define Week at a Glance
Horizontal Tiling
Vertical Tiling
Quad Tiling
Browse Notes



View: Single Window

Use this command to display one selected schedule at a time.    



View: Priority List

Use this command to display a list of all "Fluid" items ordered by priority.    For more 
information on Fluid items and how to set priority, see the section called Priorities.    



View: Alphabetical Items List

Use this command to display a list of all unarchived items in alphabetical order.    Use this list
to find an item if you have forgotten where it is in your schedule. 



View: Multiple Schedule Windows

The Multiple Schedule Windows command allows you to designate the number of schedules 
(from two to seven) that you would like to view on the screen at one time.    Unlike Week at a
Glance, which displays schedules for a chronological series of days, Multiple Windows allows 
you to display schedules for any dates, in any order, and to manipulate them independently 
from one another.



View: Week at a Glance

This command will display a week of schedules top to bottom (or side to side) on the screen.
To specify how many (up to 7) and which days of the week you would like to appear, use the 
"Define Week at a Glance" command.    To specify top to bottom or side to side select View: 
Vertical or View: Horizontal.



View: Month at a Glance

This command will display a 4 week calendar containing highlighted items for each day..    
(For more information on highlighted items see Edit: Highlight Item.) You can move backward
or forward in time in jumps of one or four weeks.

You can scroll the view a week or month at a time in the following ways:

1:    Use the mouse on the vertical scroll bar,
2:    Press the UP or DOWN arrow keys, or
3:    Press the Page UP or Page DOWN keys.

Here is a tip on how to make the best use of the relatively small Month at a Glance boxes: 
Let the first three or four words of your item description be a concise abbreviation.    Use a 
"Control+Enter" after this abbreviation; then type in the detailed description of the item.    
Above & Beyond will then display just the abbreviated summary in the Month at a Glance 
boxes.    The summary will be followed by elipses to indicate that there is more to the item 
description.

To get a Month at a Glance print out, choose File: Print: Extended Outlook.    Remember that 
only highlighted items will appear.



View: Export File

This command is an easy way to view the export file "Export.Txt".



View: History for Month

Use this command to see the archived items for a particular month.    First go to the month 
you are interested in (by using the calendar or by pressing F9 and typing in any date during 
that month).    Then select View: History for Month.



View: Define Week at a Glance

The Define Week at a Glance command is used to specify which days of the week will appear
simultaneously when you issue the Week at a Glance command. 
 
A dialog box will appear in which you will specify the desired days of the week      When the 
options are set the way you want them, select "OK".    The Week at a Glance will be 
displayed.



View: Horizontal Tiling

With Horizontal Tiling, when more than one schedule is simultaneously displayed (Multiple 
Windows or Week at a Glance), schedules are tiled side by side, across the screen. 



View: Vertical Tiling

With Vertical Tiling, when more than one schedule is simultaneously displayed (Multiple 
Windows or Week at a Glance), schedules are tiled, one above the other, on the screen. 



View: Quad Tiling

With Quad Tiling, when more than on schedule is simultaneously displayed (Multiple 
Windows or Week at a Glance), schedules are displayed in a 2 x 2 grid.



View: Browse Notes

Choosing this option will allow you to go from item to item and have the note for that item 
displayed automatically.    In    Browse Notes mode, the only "open" note will be the one 
associated with the currently selected schedule item.    A checkmark will appear beside 
Browse Notes when in this mode. To turn off Browse mode, simply select it and the check 
mark will disappear.



The Worktools Menu

In addition to AutoDial and the pop-up Timer, the worktools menu provides easy access to 
the accessories and applications you use most.    For example, the Above & Beyond 
Notebook, Windows Cardfile, Notepad and Calculator.    You may edit the worktools list 
(worktools.lst) to taylor it to your needs by choosing "Worktools: Edit Worktools List".    Here's
a sample worktools.lst file:

Phone book <TAB> C:\ab\nb.exe    C:\ab\phone.nbk
Sales leads <TAB> C:\ab\nb.exe    C:\ab\leads.nbk
Project XYZ <TAB> C:\ab\nb.exe    C:\ab\xyz.nbk

The entries before the TAB will appear in the Worktools pull-down menu.    When an entry in 
Worktools is selected, the command line after the TAB will be executed.    It's important to 
use one TAB (and no spaces) between these two parts.

In this example, there will be entries for Phone book, Sales leads, and Project XYZ.    Clicking  
on "Phone book" will run the Above & Beyond Notebook (nb.exe) loaded with the data from 
the file "phone.nbk".



AutoDial

When this command is selected, a dialog box will appear on the screen.    The first area of 
the dialog box is a text box labeled "AutoDial:"

Above & Beyond will search the currently selected item's description for a phone number.    If
there is more than one phone number, it will display the first one.    You may make changes 
to the number before dialing.    If there is no phone number found, you may type in the 
phone number you would like dialed.

The "Tone" and "Pulse" option buttons enable you to chose the type of dialing to be done.      
The "COM1", "COM2", "COM3", and "COM4" option buttons enable you to select the serial 
port that your modem is set for. 
 
When all the information in the dialog box is correct, select "OK" and the number will be 
dialed. 



Timer

With the pop-up Timer, you can easily time phone calls, meetings, or any other item. The 
Rate feature enables you to associate a value with the elapsed time (e.g. the cost of a 
telephone call or the charge for a consultation.) 
 
To activate the timer, click on Timer in the main menu bar, or press ALT+T (when the main 
window has the focus).    When the Timer window comes up, its title bar will be colored to 
indicate that the timer window currently has the focus (i.e. commands and keystrokes will be
directed to    this    window).    
 
Looking at the timer window, you can see that there is a Rate box, option buttons for 
"/Minute" and "/Hour", and Start, Stop and Reset buttons. Along the bottom of the window, 
are three number groups. The leftmost number is the current time of day. The middle 
number is the monetary value of the elapsed time based on the rate. The rightmost number 
is the actual elapsed time. 

Timer: Start, Stop, Reset
Timer: The Rate Feature
Timer: Focus To & From
Timer: Moving



Timer: Start, Stop, Reset

To start the timer, click on the Start button, or press ALT+S (when the timer window has the 
focus). 

To stop the timer, click on the Stop button, or press ALT+P.    The timer can be stopped, then 
started again without having to be reset and it start counting from the previously 
accumulated time and value. 

To stop the timer and reset the elapsed time and accumulated value to zero, click on the 
Reset button, or press ALT+E. If this is done accidentally, simply Reset again and the time 
and value figures are recalled.    



Timer: The Rate Feature

When entering the desired rate, up to six digits can be used plus a decimal point (period) to 
separate dollars from cents.    Values can accumulate up to 100,000. 
 
When the rate value is entered, click on (or press the TAB key to move the cursor over to) 
the Minute/Hour option buttons. Use the UP and DOWN arrow keys to select either the 
/Minute (per minute) or the /Hour (per hour) option.    Or you can press ALT+M to select 
/Minute or ALT+H to select /Hour. 



Timer: Switch To and From

The simplest way to move the focus from one window to another is to click with a mouse 
anywhere inside the desired window. 
 
Without a mouse, to move the focus from the main window to the timer window, press 
ALT+T. 
 
To change the focus from the timer window to the schedule window, pull down the timer 
Control menu then press S (for Switch window). 



Timer: Moving

As with any other window, you may position the timer in any desired location on the screen. 
The location of the timer will be retained across scheduler sessions.    If you are not familiar 
with the procedure for moving windows refer to Windows documentation regarding the 
Control menu .



The Schedules Menu

Use the schedules menu to quickly switch between the schedules of workgroup members.    
To view the schedule of a user, simply click on their name.

The schedules list is divided into two sections.    The upper section lists the users who are 
currently "open".    The lower section lists the users who are not open.    Clicking on a non-
open user (in the lower section) will bring up their schedule, and add them to the "open" list 
in the upper section.

Adding Users to the Schedules Menu

Use the Edit Schedules List command to add users to the list (USER.LST) of network users 
displayed in the lower section.    The following is a sample USER.LST:

Robert    <TAB>    C:\robert\robert.pak
Christy    <TAB>        J:\christy\christy.pak

"Robert" and "Christy" will appear in the schedules list; and when selected, Above & Beyond 
will look for the schedule in the file specified following the TAB.    Note:    The ".pak" extension
may be omitted as this is the default.

For    convenience in bringing up several schedules at once, you may include more than one 
datapath:

Managers    <TAB>    C:\robert\robert.pak    J:\christy\christy.pak    P:\john\john.pak

When more than one datapath is specified as above, only the password for the first ".pak" 
file will be asked for.    Remember that if passwords have not been set, when prompted 
simply press Enter to proceed.

Creating a New .Pak File

If you wish to create a new ".pak" file, first add a line as above to USER.LST indicating where 
you'd like the ".pak" file to be.    Then, in the Schedules menu, select the new entry.    A 
message "File not found. Create?" will appear.    Answer "Yes" and the new ".pak" file will be 
created.    When the new schedule is brought up, it will be "unnamed" until it is named using 
"Options: Enter Name".    Note: The name entered with the "Enter Name" command    does 
not affect the name of the ".pak" file.    The name of the ".pak" file of the currently open 
schedule can be seen by selecting "File: Name".



The Options Menu

The commands in the Options menu will allow you to enter new default settings, delete the 
sample items, enter your name as you would like it to appear in the title bar and on printed 
schedules, and order a program licence.

Calendar
Delete Sample Items
Set New Item Defaults
Enter Name
Order an Above & Beyond License
Order a Pre-paid Above & Beyond License
Order an Upgrade
Enter User ID
Set Passwords
Archive Completed Schedules
Technical Support
Alarms Off
Toolbar Off
Clock Off
Conflict Checking On
Multi-Access Support On



Options: Calendar

With the pop-up calendar you can quickly display the schedule of any date from 1987 to 
2068.    You may also instantly move any schedule item to any date.

To view the calendar press ALT+C (or click on "Calendar" in the main menu bar),    then 
select "Open".    The first time the calendar is used, it will appear in the upper right corner of 
the screen and the date of the currently selected schedule will be highlighted.    The title bar 
of the calendar will be colored to indicate that this window currently "has the focus" (i.e. 
keystrokes will be directed to this window).    To change the focus between the calendar 
window and the schedules window, press TAB.

Using the calendar and a mouse, selected schedule items may be quickly moved to any 
date.    Select the item to be moved, then click on the target date (on the calendar) with the 
RIGHT mouse button.    This will move the item to that date.

Calendar: Moving & Sizing
Calendar: Selecting Months
Calendar: Selecting Schedules
Calendar: Color Utilization
Calendar: 4-4-5 Quarterly Format



Calendar: Moving & Sizing

The calendar window has its own Control menu (press ALT+SPACEBAR when the calendar 
has the focus).    Use the Size command to change the size of the calendar and the Move 
command to move the calendar to different places on the screen.
 
The size and location of the calendar will    normally be saved along with schedule changes.   
If a size or position change is the only change made however, use the File:Save command to
retain this information across scheduling sessions.

Note:    When manipulating the calendar with the keyboard keys, the calendar must have the
focus.    Use the TAB key to switch the focus between the calendar and the main schedules 
window. 



Calendar: Selecting Months

To display the previous month on the calendar, you can either press the UP arrow key while 
the calendar has the focus, click on the UP arrow at the top of the calendar scroll bar. 
 
To display the next month, either press the DOWN arrow key while the calendar has the 
focus, or click the DOWN arrow at the bottom of the calendar scroll bar. 
    
To view the calendar for the currently displayed month in the prior year, press PAGE UP, or 
click in the gray area in the scroll bar between the UP arrow at the top of the calendar scroll 
bar and the scroll box (the white rectangle in the scroll bar). 
 
To view the calendar for the same month one year ahead, press PAGE DOWN, or click in the 
gray scroll bar area between the scroll box and the DOWN arrow at the bottom of the 
calendar scroll bar. 
 
You can also leap many years forward or backward easily by dragging the calendar scroll box
up or down within the scroll bar.    The scroll bar represents the entire range of possible 
schedules from April 1986 to December 2068.    You can jump to the middle of the calendar 
range, using a mouse, by dragging the scroll box to the middle of the gray area in the 
calendar scroll bar. 



Calendar: Selecting Schedules

Press the gray minus (-) key in the numeric key pad area to select the previous day, and 
press the gray plus (+) key to select one day ahead of the currently selected day.    As days 
are selected, they'll be displayed immediately in the schedules window.    Notice that the 
dates prior to today are crossed-out on the calendar. 

With the calendar in "standard" viewing mode ("color utilization"    not selected), you can 
easily toggle between the schedules for two dates, using the calendar and mouse.    Click on 
a date in the calendar with the left mouse button to display the schedule for that date.    If 
you click again on that same date on the calendar, the displayed schedule will switch back 
to the previously displayed schedule. 



Calendar: Color Utilization
 
By selecting Color Utilization in the Calendar menu, you can see at a glance, how full each of
your daily schedules is -- for an entire month.    On the    calendar, each day in the month has
a background color ranging from green to red; based on the percent of utilization.    Pure 
green indicates a day that is 0% scheduled.    Pure yellow indicates a day that is 50% 
scheduled.    Pure orange indicates a schedule that is 100% full.    Pure red indicates 150% 
utilization (i.e. there are conflicting items).    Days with no items appear gray.
 
Days in the past which have been archived and current or future days which have no items 
or items whose total duration is zero appear gray. The utilization is based on the length of 
your day as specified with the "Set New Item Defaults" in the Option menu.



Calendar: 4-4-5 Quarterly Format

With this option selected, Month at a Glance, the pop-up Calendar, and the Extended 
Outlook (13 week printout) will appear in 4-4-5 format.

For more information on the 4-4-5 format, please see the section titled 4-4-5 Quarterly 
Calendar.



Options: Delete Sample Items

The Delete Sample Items command will remove the sample items from the schedules.



Options: Set New Item Defaults

This command enables you to specify the default duration and time bounds that will appear 
when the insert/refine dialog box is displayed for a new item.

When the command is selected, a dialog box will be displayed.    The first text box is labeled 
"Duration". Type in the amount of time you wish to appear automatically as the duration for 
your scheduled items. Next enter the times for the "Earliest" and "Latest" that the items can 
be scheduled.    Note that by specifying the bounds here rather than individually for each 
item, you are then able to later "globally" re-adjust the bounds of all "floating" items by 
simply changing these values with Set New Item Defaults.



Options: Enter Name

Selecting the Enter Name command will cause a small dialog box to be displayed.    Type 
your name in the text box as you would like it to appear on printed schedules and in the 
Above & Beyond title bar. 



Options: Order an Above & Beyond License

Use this command to become a registered user. Selecting this command will bring a dialog 
box to the screen.    Enter your name and address and how you were introduced to this 
program. Use TAB to move from line to line within the dialog box. 
 
To print the order forms, TAB to the "Print" button and press ENTER.    Send both order forms 
and your check to the address on the form.    You will    receive your user ID in approximately 
two weeks.      
 
Select "OK" remove the dialog box from the screen. 



Options: Order a Pre-paid Above & Beyond License

Use this command to order a license if you have already paid for it, such as through a retail 
store or dealer. Selecting this command will bring a dialog box to the screen.    Enter your 
name and address and how you were introduced to this program. Use TAB to move from line 
to line in the dialog box. 
 
To print the order forms TAB to the "Print" button and press ENTER.    Please send both order 
forms to the address on the form.    You will receive your user ID in approximately three 
weeks.      
 
Select "OK" to remove the dialog box from the screen. 



Options: Order an Above & Beyond Upgrade

This option is available only to registered users of a previous release. Registered users can 
purchase a license for the upgraded version at a reduced price. Upgrades offer major 
enhancements, while updates offer incremental improvements of the current version.    
Updates are free to registered users. 



Options: Enter User ID

When you receive your user ID from 1Soft in response to your registration order, select the 
Enter User ID command. Type your user ID into the text box that appears. The word "VALID" 
should appear. 
 
If "VALID" does not appear, check the name that appears in the window's title bar.    The 
name in the title bar should be exactly the same name that printed on your order form as 
the licensee.    If it is not the same, you may correct it using the Enter Name command in the
Options menu. 



Options: Set Passwords

For workgroup (network) use,    passwords may be set to restrict the viewing and/or 
modifying of your schedules by others in the workgroup.    If no passwords are set, anyone 
will have unlimited access.

If your "view" password is set, others must enter it in order to view your schedules.    If they 
do not enter the password the schedules will appear blank.    Meetings or memos can be 
added however via the Meeting Maker.

If the "modify" password is set, others must enter it in order to make changes to your 
schedules.    Use "your" password to give total access; to view schedules, modify schedules, 
and set passwords.

You may desigante certain schedule items as "Private".    Private items can be viewed only if 
"your" password is entered.    People using your "view" or "modify" password, will see that 
there is an item scheduled (and it's duration) but cannot view or modify it.    For more 
information on private items, see Edit: Private Item in the Menu Reference Section.



Options: Archive Completed Schedules

Normally completed schedules are held for seven days before being archived to the monthly
log file.
If you wish to view or print a log file which contains all currently completed items, use the 
Archive Completed Schedules command.    This will archive all done items, even those that 
were marked done less than seven days ago.    For more information on archiving, see 
Schedule Archiving.

To print the log file select View: History for Month and then select File: Print in the notepad.



Options: Technical Support

This command will display the 1Soft technical support telephone number and hours.



Options: Alarms Off

When running in a LAN environment and viewing someone else's schedule, you will see their
alarms pop up.    To prevent this, choose "Alarms Off" in the Options menu.    This tells Above 
& Beyond to display only your alarms.    The setting you select for this option on their Above 
& Beyond schedule affects only your viewing of their schedule.    Alarms will still pop-up 
during their Above & Beyond sessions.    This setting is remembered between sessions, so 
you need only issue this command once.

Alarms Off will also prevent Exec and Autoexec items in another person's schedule from 
being launched on your workstation while you're accessing their schedule.    

The Alarms Off option may be toggled by simply selecting the command once again.    To test
the alarm sound, toggle Alarms Off off, then on again.



Options: Toolbar Off

Select this option to remove the toolbar from view.    Select it again to restore the toolbar.    
For more information on the toolbar, see Toolbar.



Options: Clock Off

When Above & Beyond is running, a small digital clock is displayed in the lower right hand 
corner of the screen.    To switch back to Above & Beyond from another application, simply 
click once on the clock.    
Select Options: Clock Off to remove the clock from view.

The color of the clock numbers corresponds to the color of Active Title Bar Text.    The color of
the clock background corresponds to the color of the Active Title Bar.    These colors may be 
set in the Windows Control Panel which can be easily accessed from the File menu in Above 
& Beyond.



Options: Conflict Checking On

With "Conflict Checking On" you will be alerted when attempting to schedule an item for a 
time period where there is already an item scheduled.    Above & Beyond will check for 
conflicts for one year into the future.    If a conflict is found, it will give you a warning 
message.



Options: Multi-Access Support On

Select this option in an environment where a schedule may be updated simultaneously from 
more than one workstation.    If only one person will be accessing your schedule at one time, 
you may de-select this option and gain a small improvement in efficiency due to reduced 
overhead. 



Technical Support Hours

Free telephone technical support is available Monday through Friday by calling during the 
hours listed below for your time zone:

Pacific U.S.: 8am - 4pm Mon - Fri
 

Mountain U.S. 9am - 5pm Mon - Fri

Central U.S.: 10am - 6pm Mon - Fri
 
Eastern U.S.: 11am - 7pm Mon - Fri

United Kingdom: 4pm - Midnight Mon - Fri

Western Europe: 5pm - 1am Mon - Fri

Sydney, Australia: 2am - 10am Tue - Sat

Hawaii: 6am - 2pm Mon - Fri



Compuserve

Besides telephone technical support, help is also available on CompuServe.    Messages can 
be addressed to CIS ID 71240,1625.    Many of the participants on the WINADV and IBMAPP 
forums are Above & Beyond users.


